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Limited Warranty

The media on which you receive National Instruments software are warranted not to fail to execute
programming instructions, due to defects in materials and workmanship, for a period of 90 days from
date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its
option, repair or replace software media that do not execute programming instructions if National
Instruments receives notice of such defects during the warranty period. National Instruments does
not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly
marked on the outside of the package before any equipment will be accepted for warranty work.
National Instruments will pay the shipping costs of returning to the owner parts which are covered
by warranty.

National Instruments believes that the information in this manual is accurate. The document has
been carefully reviewed for technical accuracy. In the event that technical or typographical errors
exist, National Instruments reserves the right to make changes to subsequent editions of this
document without prior notice to holders of this edition. The reader should consult National
Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES,
EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER'S RIGHT
TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID
BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BELIABLE FOR DAMAGES
RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This
limitatjon of the liability of National Instruments will apply regardless of the form of action, whether
in contract or tort, including negligence. Any action against National Instruments must be brought
within one year after the cause of action accrues. National Instruments shall not be liable for any
delay in performance due to causes beyond its reasonable control. The warranty provided herein
does not cover damages, defects, malfunctions, or service failures caused by owner's failure 1o
follow the National Instruments installation, operation, or maintenance instructions; owner's
modification of the product; owner's abuse, misuse, or negligent acts; and power failure or surges,
fire, flood, accident, actions of third parties, or other events outside reasonable control.
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Copyright |

Under the copyright laws, this publication may not be reproduced or transmitted in any form,
electronic or mechanical, including photocopying, recording, storing in an information retrieval
system, or translating, in whole or in part, without the prior written consent of National Instruments
Corporation.

Trademarks

LabVIEW® is a trademark of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

Warning Regarding Medical and Clinical Use
of National Instruments Products

National Instruments products are not designed with components and testing intended to ensure a
level of reliability suitable for use in treatment and diagnosis of humans. Applications of National
Instruments products involving medical or clinical treatment can create a potential for accidental
injury caused by product failure, or by errors on the part of the user or application designer. Any use
or application of National Instruments products for or involving medical or clinical treatment must
be performed by properly trained and qualified medical personnel, and all traditional medical
safeguards, equipment, and procedures that are appropriate in the particular situation to prevent
serious injury or death should always continue to be used when National Instruments Products are
being used. National Instruments products are NOT intended to be a substitute for any form of
established process, procedure, or equipment used to monitor or safeguard human health and safety
in medical or clinical treatment.
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About This Manual

The LabVIEW for Windows User Manual discusses how to create, edit,
and execute virtual instruments (VIs) using LabVIEW. This manual
explains the front panel and block diagram; numeric, Boolean, string,
array and cluster controls and indicators; graphs and charts; and wiring
the block diagram.

You should read the LabVIEW release notes and your tutorial manual
before you use the LabVIEW for Windows User Manual.

Organization of This Manual

LabVIEW Basics

This manual covers three subject areas. Chapters 1 through 3 introduce
basic LabVIEW ideas. Chapters 4 through10 explain how to use front
panel objects. Chapters 11 through 19 explain block diagram
programming objects and techniques.

»  Chapter 1, Introduction to LabVIEW, discusses the unique
LabVIEW approach to programming. It also contains basic
information that explains how to start using LabVIEW to develop
programs, referring you to other chapters or manuals for more
information.

*  Chapter 2, Editing Vs, discusses editing techniques for the front
panel and the block diagram.

*  Chapter 3, Executing Vls, discusses how to operate and debug Vls,
explains how to set up VIs and subVls for special execution modes,
and discusses factors that affect execution speed.

© National Instruments Corporation xvii . LabVIEW for Windows User Manual

DEFS 00031608
Page 21 of 460



About This Manual

Front Panel Objects

»  Chapter 4, Introduction to Front Panel Objects, introduces the front
panel and its two component parts, controls and indicators.

»  Chapter 5, Numeric Controls and Indicators, explains how to edit
and operate numeric controls and indicators.

»  Chapter 6, Boolean Controls and Indicators, discusses how to
create and operate Boolean controls and indicators.

-« Chapter 7, String and Table Controls and Indicators, discusses how
to use string controls and indicators, and the table.

»  Chapter 8, Array and Cluster Controls and Indicators, describes
how to use LabVIEW arrays and clusters.

»  Chapter 9, Graph and Chart Indicarors, describes how to create
and use graph and chart indicators.

»  Chapter 10, Path Controls and Refnums, describes how to use file
path controls and refnums.

Block Diagram Programming

»  Chapter 11, Introduction to the Block Diagram, describes nodes,
terminals, and wires—the elements you use to build a block diagram.

»  Chapter 12, Wiring the Block Diagram, explains how (o wire the
block diagram, which is the VI program, and how to debug
nonexecutable Vls.

*  Chapter 13, Structures, describes how to use the For Loop, While
Loop, Case, and Sequence structures.

»  Chapter 14, The Formula Node, describes how to use the Formula
Node to execute mathematical formulas on the block diagram.

+  Chapter 15, Atrribute Nodes, describes how to use Attribute Nodes
to set and read attributes of front panel controls programmatically

»  Chapter 16, Global and Local Variables, describes how to define
and use global and local variables.

+  Chapter 17, File VIs, describes the utility Vls that perform high-
and intermediate-level file I/O operations.
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«  Chapter 18, Error Handler Vls, describes a set of VIs for managing
and reporting errors.

«  Chapter 19, VI Setup Options, lists the VI setup options you can use
to create special effects in your Vls.

Appendices, Glossary, and Index.

» Appendix A, Data Storage Formats, discusses the formats in which
LabVIEW saves data.

+ Appendix B, Error Codes, contains tables of numerical error codes
drawn from the entire LabVIEW documentation set.

«  Appendix C, Customer Communication, contains forms you can
use to request help from National Instruments or to comment on our
products and manuals.

+  The Glossary contains an alphabetical list and description of terms
used in this manual.

«  The Index contains an alphabetical list of key terms and topics in
this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual:

bold Bold text denotes parameter names, menus, menu
: items, or dialog box buttons or options.
italic Italic text denotes emphasis, a cross reference, or
an introduction to a key concept.
bold italic Bold italic text denotes a note, caution, or
warning.
monospace Monospace font denotes text or characters that

you enter using the keyboard. File names,
directory names, drive names, sections of code,.
programming examples, syntax examples, and
messages and responses that the computer
automatically prints to the screen also appear in
this font. :
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<>

A

Warning:

Caution:

Note:

Angle brackets enclose the name of a key on the
keyboard-for example, <f>.

A hyphen between two or more key names
enclosed in angle brackets denotes that you hold
down the first key while you press the next
key(s)—for example, <shift-enter>,

Thisicon to the left of bold italicized text denotes
a warning, which alerts you to the possibility of
damage to you or your equipment.

Thisicon to the left of bold italicized text denotes
a caution, which alerts you to the possibility of
data loss or a system crash.

This icon to the left of bold italicized text denotes
a note, which alerts you to important
information.

Abbreviations, acronyms, metric prefixes, mnemonics, symbols, and
terms are listed in the Glossary.

Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with our
products, and we want to help if you have problems with them. To make
it easy for you to contact us, this manual contains comment and ,
configuration forms for you to complete. These forms are in Appendix C,
Customer Communicarion, at the end of this manual.

LabVIEW for Windows User Manual
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Introduction to LabVIEW

This chapter discusses the unique LabVIEW approach to programming.
It also contains basic information that explains how to start using
LabVIEW to develop programs. The chapter refers you to other chapters
or manuals for more information. Please read the LabVIEW release notes
and your tutorial manual before you use the LabVIEW for Windows User
Manual.

What Is LabVIEW?

LabVIEW is a program development application, much like C or
BASIC, or National Instruments LabWindows. However, LLabVIEW is
different from those applications in one important respect. Other
programming systems use texs-based languages to create lines of code,
while LabVIEW uses a graphical programming language, G, to create
programs in block diagram form.

LabVIEW, like C or BASIC, is a general-purpose programming system
with extensive libraries of functions and subroutines for any
programming task. LabVIEW also contains application-specific libraries
for data acquisition, GPIB and serial instrument control, data analysis,
data presentation, and data storage. LabVIEW also includes
conventional program development tools, so you can set breakpoints,
animate the execution to see how data passes through the program, and
single-step through the program to make debugging and program
development easier.

How Does LabVIEW Work?

LabVIEW is a general-purpose programming system, but it also includes
libraries of functions and development tools designed specifically for
data acquisition and instrument control. LabVIEW programs are called
virtual instruments (VIs) because their appearance and operation imitate
actual instruments. However, they are identical to functions from
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Introduction to LabVIEW Chapter 1

conventional language programs. VIs have an interactive user interface,
a source code equivalent, and accept parameters from higher level VIs.
These three VI features are discussed below.

»  The interactive user interface of a VI is called the front panel,
because it simulates the panel of a physical instrument. The front
panel can contain knobs, push buttons, graphs, and other controls
and indicators. You input data using a mouse and keyboard, and
then view the results on the computer screen.

+  The VI receives instructions from a block diagram, which you
construct in G. The block diagram is a pictorial solution to a

programming problem. The block diagram is also the source code
for the V1.

*  VIs are hierarchical and modular. You can use them as top-level
programs, or as subprograms within other programs or
subprograms. A V1 within another VI is called a subVI. The icon
and connector of a VI work like a graphical parameter list so that
other VIs can pass data to a subV1L.

With these features, LabVIEW promotes and adheres to the concept of
modular programming. You divide an application into a series of tasks,
which you can divide again until a complicated application becomes a
series of simple subtasks. You build a VI to accomplish each subtask and
then combine those VIs on another block diagram to accomplish the
larger task. Finally, your top-level VI contains a collection of subVIs that
represent application functions.

Because you can execute each subVI by itself, apart from the rest of the
application, debugging is much easier. Furthermore, many low-level
subVIs often perform tasks common to several applications, so that you

- can develop a specialized set of subVIs well-suited to applications you
are likely to construct.

The next sections further explain the front panel, block diagram, icon,
connector, and other related features.
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Chapter 1 Introduction to LabVIEW

Front Panel

The user interface of a VI is the same as the user interface of a physical
instrument~the front panel. A front panel of a VI might look like the
following illustration.
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The Panel window displays the front panel of a V1. The front panel is
primarily a combination of controls and indicators. Controls simulate
instrument input devices and supply data to the block diagram of the V1.
Indicators simulate instrument output devices that display data acquired
or generated by the block diagram of the VL.

You add controls and indicators to the front panel by selecting them from
the Controls menu at the top of the Panel window. You can change the
size, shape, and position of an object. In addition, each object contains a
pop-up menu with which you can change object attributes. You access
this pop-up menu by clicking with the right hand mouse button on the
object.

Read Chapter 2, Editing VIs, then see the Frornit Panel Objects section of
this manual (Chapters 4 through 10) for information on building a front
panel.
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Block Diagram

The Diagram window holds the block diagram of the VI, the graphical
source code of a LabVIEW VI. You construct the block diagram by
wiring together objects that send or receive data, perform specific
functions, and control the flow of execution.

The following simple VI computes the sum of and difference between
two numbers. The diagram shows scveral primary block diagram
program objects—nodes, terminals, and wires.

: addsubVl Biagram ™.~ . -
File Edit O C E perate Functions Windows Text :|
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g ) >
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Eﬁﬂﬂ “ 000 ] ol
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> o
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When you place a control or indicator on the front panel, LabVIEW
places a corresponding terminal on the block diagram. You cannot delete
a terminal that belongs to a control or indicator. The terminal disappears
only when you delete its control or indicator.

The Add and Subtract function icons also have terminals. Think of
terminals as entry and exit ports. Data that you enter into the controls (a
and b) exits the front panel through the control terminals on the block
diagram. The data then enrers the Add and Subtract functions. When the
Add and Subtract functions complete their internal calculations, they
produce new data values at their exir terminals. The data flows to the
indicator terminals and reenters the front panel, where it is displayed.
The data exits from a source terminal and enters a destination or sink
terminal.

Nodes are program execution elements. They are analogous to
statements, operators, functions, and subroutines in conventional
programming languages. The Add and Subtract functions are one type of
node. LabVIEW has an extensive library of functions for math,
comparison, conversion, I/0, and more. Another type of node is a
structure. Structures, similar to loops and case statements in traditional
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Chapter 1 Introduction to LabVIEW

programming languages, repeatedly or conditionally execute code.
LabVIEW also has special nodes for linking to external text-based code
and for evaluating text-based formulas.

Wires are the data paths between source and sink terminals. You cannot
wire a source terminal to another source or a sink terminal to another
sink, but you can wire one source to several sinks. Each wire has a
different style or color, depending on the data type that flows through the
wire. The previous example shows the wire style for a numeric scalar
value—a thin, solid line.

The principle that governs LabVIEW program execution is called data
flow. Stated simply, a node executes only when data arrives at all its input
terminals; the node supplies data to all of its output terminals when it
finishes executing; and the data passes immediately from source to sink
(or destination) terminals. Data flow contrasts with the control flow
method of executing a conventional program, in which instructions are
executed in the sequence in which they are written. Control flow
execution is instruction driven. Dataflow execution is data driven or data
dependent.

See the Block Diagram Programming part of this manual (Chapters 11
through 19) for in-depth information on using block diagram objects to
build a program.

Icon and Connector

When your VI operates as asubVI (the LabVIEW analog of a subroutine)
inside another VI, the controls and indicators receive data from and
return data to the calling VL.

The icon represents a VI in the block diagram of another VI. The
connector is a set of terminals that correspond to the subVI controls and
indicators. The icon can be the pictorial representation of the purpose of
the VI, or it can be a textual description of the VI or its terminals.

The connector is much like the parameter list of a function call; the
connector terminals act like parameters. Each terminal corresponds to a
particular control or indicator on the front panel. A connector receives
data at its input terminals and passes the data to the subV1 code via the
subVI controls, or receives the results at its output terminals from the
subVT indicators.
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Every VI has a default icon, which is displayed in the icon pane in the
upper right comer of the Panel and Diagram windows. The default icon
is a blank frame, as shown in the following illustration.

Untltled 1

- ]
1con / l__ﬂ

pane

Every VI also has a connector, which you access by choosing Show
Connector from the Panel icon pane pop-up menu. When you show the
connector for the first time, LabVIEW suggests a connector pattern. You
can select a different pattern if you want. The connector generally has
one terminal for each control or indicator on the front panel. You can
assign up to 20 terminals. You can leave terminals unconnected, then
connect them later without invalidating old VIs.

These topics are more fully discussed in Chapter 2, Ediring VIs.

Introduction to the LabVIEW Development System

This section explains basic features of the LabVIEW development
system, such as menus, tools, windows and modes, and explains how 1o
load, print, and save VIs. Subsequent chapters explain how to use
LabVIEW VI editing and operating features.

Using LabVIEW Menus

LabVIEW uses menus extensively. The menu bar at the top of a VI
window contains several pull-down menus. When you click on a menu
bar item, a menu appears below the bar. The pull-down menus contain
items common to many applications, such as Open, Save, Copy, and
Paste, and many others particular to LabVIEW. Many menus also list
shortcut key combinations for you to use if you choose,

The LabVIEW menu you will use most often is the object pop-up menu.
Virtually every LabVIEW object, as well as empty front panel and block
diagram space, has a pop-up menu of options and commands.
Instructions throughout the manual suggest that you select a command or
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option from an object pop-up menu. Your LabVIEW tutorial manual
explains popping up in more detail.

Menu items that expand into submenus are hierarchical menus and are
denoted by a right arrowhead, as shown in the following illustration.
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Chart History Length...
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6rid Style
Lagsp Fif

: »

R
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Logarithmic

Hierarchical menus sometimes have a selection of mutually exclusive
options. The currently selected option is denoted by a check mark, as
with the Linear option in the preceding illustration.

The Representation menu shown in the following illustration is an
example of a palette menu, which uses icons to represent options. Notice
that the currently selected option in a palette menu is framed or
highlighted.

Change {o Indicator
Find Termina! .
Show

Data Operations

Create Attribute Node

Replace

" Bepresentation. - -

Data Range...
Format & Precision...

u3z |[vie |[ us
31 0 130 10
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Adapt To Source

Menu items leading to dialog boxes are denoted by ellipses, as in Data
Range... above.
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Menu items without right arrowheads or ellipses are usually commands
that execute immediately when selected. A command usually appears in
verb form, such as Change To Indicator. When selected, many
commands are replaced in the menu by their inverse commands. For
example, after you choose Change To Indicator, the selection becomes
Change To Control.

Diagram and Panel Windows

Each VI has two separate but related windows. The Panel window
contains the front panel of your VI. The Diagram is the window in which
you-build your block diagram. You can switch between windows with
the Show Panel/Show Diagram command in the Windows menu. You
can also position them side-by-side with the Tile command, also in the
Windows menu.

Edit and Run Modes

A Vlis either in edit mode, in which you can create or change a VI, or
run mode, in which you can execute a VI. You cannot edit a V1 in run
mode.

In edit mode, the editing tools become available on the edit mode palette
below the window menu bar, as shown below. See the Tools section of
this chapter for more information.

2]h Y [AlRIF

When you are ready to test the VI, click on the mode bution or select

Change to Run Mode from the Operate menu. This compiles your VI
and puts the VI in run mode. At this point you can set debugging options,
run the VI, place the VI in continuous run mode, or print data. If you just
want to run the VI from edit mode without setting other options in the run
mode palette, click on the run arrow. If necessary, LabVIEW compiles
the VI first, then switches the VI to run mode, runs the V1, and switches
back to edit mode aftcr the VI has run.

mode button
(in edit mode)
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The run mode palette is shown in the following illustration. In run mode,
various debugging options become available. Refer to Chapter 3,
Executing VIs, for more information on debugging options.

R NLE EkIipY

E- If you want to switch to edit mode from run mode, click on the mode
* button or select Change to Edit Mode from the Operate menu. If you
mode button run the VI from run mode, the VI is still in run mode after executing.

(in ran mode)

Tools

A tonl is a special operating mode of the mouse cursor. You use tools to
perform specific editing functions.

The Operating tool, shown at left, operates front panel controls (and
indicators in edit mode). This is the only tool available in run mode.

The Positioning tool, shown at left, selects, moves, and resizes objects.

The Labeling tool, shown at left, creates and edits text labels.

The Wiring tool, shown at left, wires objects together on the block
diagram and assigns controls and indicators on the front panel to
terminals on the VI connector.

4 2

The Coloring tool, shown at lett, colors various objects and backgrounds.

"%

You change tools by clicking on the tool icon you want in the edit mode
palette, or by pressing the tab key, which selects the next tool in
sequence. You can also press the space bar to toggle between the
Operating tool and the Positioning tool when the Panel window is active,
and between the Wiring tool and the Positioning tool when the Diagram
window is active.

Help Window

The LabVIEW Help window offers help information for functions,
constants, subVlIs, and controls and indicators. To display the window,
choose Show Help Window from the Windows mena. You can move
the Help window.
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‘When you move a tool onto a function, a subVI node, or a VI icon
(including the icon of the VI you have open, at the top right of the VI
window), the Help window shows the icon for the function or subVI with
wires of the appropriate data type attached to each terminal. Input wires
point to the left, and output wires point to the right. Terminal names
appear beside each wire. If the VI has a description associated with it,
this description is also displayed. VI descriptions are entered in the
Geltlnfo dialog for the VL.

If you do not have to wire a function input, the default value LabVIEW
appears in parentheses next to the name. If the function can accept
multiple data types, the Help window shows the most common type.

The terminal names for subVI nodes are the labels of the corresponding
front panel controls and indicators. All subVI node inputs are optional,
and the default value does not automatically appear in the wiring
diagram. It is a good idea, however, to include the default value in
parentheses in the name of controls when you create a subVI.

When you move a tool over a universal constant, the Help window
displays the constant's value.

‘When you move a tool over a control or indicator, the Help window
displays the description for that particular control or indicator.

When you place a tool over a wire, the Help window displays the data
type carried by that wire.

If you hold atool on a Vlicon in a VI palette for a few moments, the Help
window will display help for that VI. The delay is updating the help
window from a VI palette is to avoid slowing down LabVIEW when you
do not need help in selecting which VI you want to use.

To close the Help window, click on its close box. See the Online Help for
Constants, Functions, and SubVI1 Modes section of Chapter 11,
Introduction to the Block Diagram, for more information on Help.

Printing VIs

You can print the front panel, block diagram, or other selected
components of the current VI by choosing Print... from the File menu.
Ycu can also set up a VI to print its front panel at the end of execution
(programmatic printing), as explained in the Printing Programmatically
section in Chapter 3, Executing VIs.
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To print a VI, make it the active window by clicking on its front panel or
block diagram. Choose Print... from the File menu. Click on OK to print
the VI according to the settings in Page Layout. Click on Cancel to
return to the VI without printing.

To select printing options, choose Page Layout... from the File menu.
The following dialog box appears.

Page Layout

B4 Print Header
B4 Print Higrarchy
Print Connector Pane and Descnption

< Print Front Panel
[J Page Break Before Front Panel

Print Block Diagram

[] Page Break Before Block Diagram
B4 Print Hidden Frames

[]1 Repeat Frames Printed at Higher Level

Cancel

et Lt s e N e A A

The following list describes whal happens if you mark the check boxes
in the dialog box.

»  Print Header prints the icon, VI name, page number, and date of
the last save at the top of each page.

«  Print Hierarchy prints a tree diagram of all VIs currently loaded
into memory. This tree diagram is similar to the one that appears
when you select Show Hierarchy from the Windows menu. Vs
and their subVls are connected by lines. The current V1is
highlighted.
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*  Print Connector Pane and Description prints the V1
icon/connector and the description entered in the Description
dialog box.

e  Print Front Panel prints the front panel of the VI.

— Page Break Before Front Panel prints the front panel on a
new page.

»  Print Block Diagram prints the block diagram of the VI.

— Page Break Before Block Diagram prints the block diagram
on a new page.

— Print Hidden Frames prints all the cases and frames of Case
and Sequence structures in the block diagram of the VI. As
LabVIEW prints each structure, its underlying frames are also
printed, beginning with frame O.

*  Repeat Frames Printed at Higher Level may print subdiagrams
of a structure more than once. For example, if a block diagram
contains nested Sequence structures, LabVIEW prints the inner
Sequence structure subdiagram currently displayed on the block
diagram once when the entire block diagram is printed, once when
the outer Sequence structure is printed (because the inner sequence
structure is in one of the outer Sequence structure subdiagrams),
and once when the inner Sequence Structure is printed. If this
option is unchecked, each subdiagram prints only once.
Subdiagram 0 of a structure always prints first, regardless of which
subdiagram on the block diagram currently displays.
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Previewing a VI

Select Print Preview... to display selected VI components as they will
appear when-printed, as shown in the following illustration.

T Print Preview

addésub
02115/92 10605 AM

Pasition in Hierarchy

[

Connector Pare

O

Front Panel
[N pw]
Hooal

Inond

3 =3
Hooal  [@Ad)

Block Diagram

B> — i
> 6

Enhancing Printouts with Transparency and Decorations/Bitmaps

Controls in their standard configurations may not provide the kind of
printout that you want in certain situations. For example, you may not
want the shells of LabVIEW controls to be visible for reports, or you may
want to include graphics, such as company logos.

In most cases, you can set up a subV1 for printing in the desired format,
as described in the section Printing Programmatically in Chapter 3,
Executing VIs. By making the shells of controls transparent with the
coloring tool, you can simplify the appearance of a front panel. The
graphical objects from the Decorations menu are also useful for visually
grouping objects. Finally, you can import bitmaps from paint programs
to customize the panel for printouts.
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Saving VIs

You save VIs through file dialog boxes that resemble dialog boxes in
other applications on your operating system. If you save Vls as
individual files, they must conform to the filenaming restrictions of your
operating system. To avoid these restrictions and save disk space, save
VlIs in a compressed form in a file called a VI library. See the VI
Libraries section for more information.

LabVIEW references VIs by name. You cannot have more than one VI
or subVI with a given name in memory at one time. If you have two VIs
with the same name, LabVIEW will load the first VI it finds without
loading the other.

Save Options

You can save VIs with one of four save options in the File menu. Select
the Save option to save a new VI, specifving a name for the VI and its
destination in the disk hierarchy, or to save changes to an existing VI in
a location previously specified.

Select the Save As... option to rename the VI in memory and to save a
copy of the VI to disk. If you enter a new name for the V1, LabVIEW
does not overwrite the disk version of the original V1. If you do not
change the name of the VI in the dialog box, LabVIEW prompts you to
verify that you want to overwrite the original file.

When you select the Save A Copy As... option, LabVIEW saves a copy
of the VI in memory to disk under a different name, which you enter in
the dialog box. This does not affect the name of the VI in memory.

~ Save with Options... brings up a dialog box in which you can choose to
save an entire V] hierarchy in memory to disk (the Save Entire
Hierarchy option) and optionally save the VI, or VIs, without a block
diagram to prevent further changes to the V1. You can save the VI, or
VIs, without the block diagram only if you select To New Location(s),
which prompts you with new location options. This forces you to make
a copy of the VI or VIs. If you select To Current Location(s),
LabVIEW does not prompt you to specify the location. To save a
specified VI or VIs to a single location without being interrupted by
multiple prompts, use To VI Library.

A\

Caution: You cannot edit a VI after you save it without a block diagram. Always
make a copy of the original VI.
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Revert

Y ou can use the Revert... option in the File menu to return to the last
saved version of the VI you are working on. A dialog box will appear to
confirm whether to discard any changes in the V1. '

V1 Libraries

The VIs distributed with LabVIEW in the vi. 1ib directory are
organized in VI libraries. These libraries appear as palettes in the
Functions menu. For instance, the analysis VIs are contained in library
files in a directory titled ANALYSIS. When you select GPIB from the
Functions menu, a submenu with two options appears. When you select
an option from that submenu, a palette of VIs appears.

Structs & Constants 1
Arithmelic

Trig & Log

Comparison

4

>

| TR
Conuersion > . ENNE kil l
String > ()| | ad | [ <mip | [ b | | Gam <D
Array & Cluster 4 GEE [EEE [0EE [gEE| | HEE |HHE) 8EE

> |

>

>

14

>

»

slele
File 170
Dialog & Date/Time

F:} e | (<20 || <G| |G | |[€mmd | <
Fee) [EEE (EEE FEE | o v ) GEe e
=D

Miscellaneous o[>
Ut ... -onta || seve || omos | Inssersd] | scrum LY || wane
113 11]

GPIB o 4882 . . -

Piclure Traditional GPIBX b

Note: Do not save your own VIs in the vi . 1ib directory. This directory is
updated by National Instruments as needed during new version
releases of LabVIEW. Placing VIsin vi . 1ib risks creating a conflict
during future installations. Place VIs in .1ib directories adjacent to,
but not inside, the vi . 11D directory instead.

In file dialog boxes, a V1 library appears as a folder with an extension of
. 11o appended to the name, as shown in the following illustration.

(0 GSTRT.LLB
6o MYVI.LLB
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Libraries have the same load, save, and open capabilities as directories.
However, VI libraries are not directories; they are files. They cannot
contain other VI libraries or directories. Libraries contain compressed
versions of VIs. While compression and decompression time during
loads and saves varies depending on drive speed and computer speed, the
extra time libraries use is minimal, and the disk space they save is always
substantial. Another advantage for some platforms is that VIs saved in a
library are not bound by the operating system naming restrictions. VI
names can contain up to 31 characters, including spaces and the . vi
extension, and are not case sensitive. Also, libraries are more portable
among different platforms. The library name must conform to the
operating system filename restrictions.

You create a VI library by clicking on the New... button of the Save,
Save as..., or Save a Copy As... dialog box, as shown in the following
illustration.

" File Dialog - .

VLLIB

_SERSUP.LLB
3 AHALYSIS
S DAQ -
£ GPIB
0 GSTRT.LLB
I NETWORK
0 SERIAL.LLB
CyUTILITY

Hame the VI
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Enter the name of the new library in the dialog box that appears and
append an . 11b extension. Then click on the VI Library button. If you
do not include the . 11b extension, LabVIEW adds it.

.- New Directory or Vi L_i;brary—

Mame of new directory or ¥Vl Library:

E xamples_lIb

I Directory a Cancel :
‘ ¥l Librag g

You can remove a file from a VI library using buttons in the dialog box
displayed by the Edit VI Library... option of the File menu.

Accessing Your VI Library from the Functions
Menu

When you start LabVIEW, the application looks in the LabVIEW
directory for directories ending in. 1ib. LabVIEW builds paletie
menus for all V1 libraries or directories inside of . 1ib directories. If you
want your VIs to appear in the Functions menu, create your own
directory ending in . 1ib, and place directories or VI libraries in that
directory. When you restart LabVIEW, it creates palettes for each of
these directories and VI libraries and adds them to thc Functions menu.
LabVIEW arranges Vs alphabetically for directories. For VI libraries,
LabVIEW arranges VIs according to the layout you create with the Edit
VI Library... option in the File menu.

Your VIs must be in 4 directory or a V1 library within the . 1ib
directory. LabVIEW will not display an individual VI on a palette if it is
saved directly into the . 1ib directory.
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Edit VI Library Dialog

You can use the Edit VI Library dialog box to edit the contents of a VI
library. You can selectively delete files from a VI library, You can also
define control and function palettes, and palette names, to use for menus
if the VI library is placed in a .1ib library directory (see the Saving a
Custom Control and Adding a Custom Controls Menu sections of
Chapter 4, Introduction to Front Panel Objects, for more information).
When you define the palettes, you do not have to have all VIs and
controls visible in the palette; you can hide or show the VIs and controls

you .want.

ez :

~_Edit Ul Library..:

&

The Edit VI Library dialog box initially displays a list of the files in the
Vl1library. As you move through the list, the creation date and last
modification date for the selected file is shown at the bottom of the dialog
box.

- Edit ¥l Library -

ElDigital Thermometer.
B Demo Send.vi ‘
8 Demo Receive.vi Functions Menu Name

View | by Name A

8 Demo Tek FG 5010.vi IGelling Started I
8 Demo Fluke 8840A.vi

B8 Temperature Analysis.vi Contiols Menu Name

8 Temperature Monitor.vi L ]
B8 Temperature Control.vi
8@ Temperature System.vi
B Demo Voitage Read.vi
H Frequency Response.vi

ﬂ‘remp

Creation Date 03/21/26 12:49 PM DAuto-Load

Last Modified 02/12/27 10:08 AM
OK E | Cancel g

| Icons at the left side of the list indicate the status of each file. The icon
shown at the left indicates that the file is visible in a palette. You can add

file visible a file to the palettes or remove it by using the Hide/Show button.
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The icon shown at the left indicates that the file is marked for deletion.
E You select and deselect files for deletion with the Delete/Restore buttons.
file marked Marked files are only deleted if you select the OK button.

for deletion
You can view the function paletté¢ menu (used in the Functions menu for
placing VIs and globals) or the control palette menu (used in the
Controls menu for placing custom controls and typedefs) by using the
View popup menu.

View |+ by Name
Function Menu
Control Menu

If you select one of the palette menus, the list is replaced by an icon grid
showing the arrangement of the icons you've selected for visibility in the
palette menu. The menu name used for the palette is determined by the
Functions Menu Name and Controls Menu Name fields.

VT Edit VI Library

Wﬁtg HT""P <§Jm:§> Q‘F,Iﬁ'\vy . View | Function Menu W}
Read »2Hs || oERs

R Functlions Menu Name

anh inn, [ET:tling Started l

L ‘ ﬂ @
e TP i Controls Menu Name
é;g SYS| o [ETRy | [ARey

I ]

ﬂTemp

JAuto-Load

l 0K 3 r Cancel 3

The Auto-Load option has two uses. If you are creating an application,
selecting Auto-Load controls which VIs open automatically when you
run the application.

If you launch LabVIEW with a command line option specifying a
particular library, selecting Auto-Load determines which Vls load
automatically.

~

© National Instruments Corporation 1-19 LabVIEW for Windows User Manual

DEFS 00031632
Page 45 of 460



Introduction to LabVIEW Chapter 1

Configuring LabVIEW

The preferences dialog lets you configure a number of default parameters
and customize LabVIEW. These options let you set up the application
memory, specify LabVIEW search paths, and change default options.

You access the preferences dialog by selecting Preferences... from the
Edit menu.

Preferences...

The dialog initially displays a set of preferences that let you configure
memory and disk space requirements. The pull-down menu at the top of
the dialog lets you select among the different categories of preferences.

Memory & Disk W

'

v Memory & Disk
Paths
Display
Miscellaneous

Most of these options have a default value, which is initially displayed.

To change the default, deselect the Use Default check box and specify
the new value.

Data Memory Size (KBytes): 1394 [X Use Default

Data Memory Size (KBytes):[1394 |[] Use Default
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How Preferences are Stored

You will not usually have to edit preference information manually, or
know its exact format, because the preferences dialog takes care of it for
you.

Preference information is stored in a LabVIEW. INI file in your
WINDOWS directory. The format for this file is similar to other . INI
files, such as the WIN. INT file. It begins with a section marker
(LabVIEW]. This is followed by variable labels and their values, such
as totalMemSize=5000000. If a configuration value is not defined
in LABVIEW. INI, LabVIEW will check to see if there is a
[LabVIEW] section of your WIN. INT file, and if so, check for the
configuration value in that file.

Memory and Disk Preferences

Y-ou configure memory and disk space requirements using the following
page of the preferences dialog.

oL U Preférences . Y

[ Memory & Disk ﬂ

~ Total Memory Size [KBytes): [4096 Use Default
Data Memory Size [KBytes): [1024 Ed Use Default

Check available disk space during launch

Aboit if less than (KBytes): (X Use Default
Warn if less than (XBytes): [2000 <] Use Default

elp messages for a control are displayed here when the mouse is placed over the
icontrol.

l 0K :g lCancel g
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When you launch LabVIEW, it will allocate a block of memory of the
size selected for Total Memory Size. LabVIEW uses this memory for
all of its memory allocation. Of this number, some is reserved strictly for
use by the diagram for storing data. The rest is used by the application.
Data Memory Size specifies how much memory out of the total
available is allocated for storing data.

While it executes, LabVIEW maintains temporary files on disk. For
example, when you save a VI, LabVIEW first saves it into a temporary
file. If the save is successful, the original is replaced with the new file.
LabVIEW needs a fair amount of disk space for these operations. To
avoid problems, LabVIEW normally checks for disk space at launch
time. If you have less than 500 KB of disk space free, LabVIEW will
alert you and quit. If you have less than 2 MB available, LabVIEW will

“warn you, but continue. You can turn these wamings off or change the
levels at which they alert you using the options at the bottom of this
dialog.
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Path Preferences
You can specify the directories that LabVIEW searches when searching

for VIs as well as the paths LabVIEW uses for temporary files and the
library directory. Use the Paths page of the Preferences dialog.

Preferences

Libsaiy Directory v] [J Use Defauit

l—Blowse... § f‘isr

{ insest Betore “ fnvert Ales 'r Replace EX flomove %

Closes the Preferences dialog and saves any changes.

IDK§

At the top of this dialog box is a pull-down menu you can use to select
the path you want to view or edit.

¥ Library Birectory
Temporary Directory
Oefault Directory °
Ul Search Path
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Initially, the controls in the middle of this dialog that let you edit a path
are grayed out. If you want to change one of these preferences, deselect
the Use Default check box. .

B Use Default——»[ ] Use Default

Library, Temporary, and Default Directories

The Library Directory, Temporary Directory, and Default Directory
are single directories. When you edit one of these paths, you are given
options that let you type in a new path and replace the existing path, or
browse using the file dialog box to select a path.

path category |
, current value new value

[J Use Default
| |

insent Hotose E tncort Abes l Replace g’ flomove

L Library Directory VI

CCALN30 e e

A ]

Browse... § i r

........

The library directory specifics the absolute pathname to the directory
containing vi.lib and any library directories you supply. The default is the
directory containing LabVIEW.,

The temporary directory specifies the absolute pathname to the
directory for temporary files. The default is the directory containing
LabVIEW.,

The default directory specifies the absolute pathname to the default
directory, which is the initial directory the File dialog box displays. The
Default Directory function also returns this value. The default is the
current working directory.
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V1 Search Path

The VI Search Path is the list of directories that LabVIEW searches when
looking for a VI, control, or external subroutine. When you edit the
search path, you are given more options than for the other paths—you
can add new items in specific locations, remove paths, and select from a
list of special paths.

, V1 Seasch Path :l [J Use Default

<foundvi>
<vilib>\*

r Browse... §E|L ' J

i Insest Beloteil Insert After gl Replace g[ Remove %

The list indicates paths that LabVIEW will search, in the order that
LabVIEW searches them. To add a new directory, you first need to
decide when LabVIEW should search that directory relative to the other
directories. Select an adjacent directory from the list. Then use either the
browse button, which displays a file dialog box, or the special pull-down
menu, which gives a list of special paths, to select the directory that
LabVIEW should search. You can also edit or enter this path in the string
control next to these options. Finally, use Insert Before, Insert After, or
Replace to add that option to the list.

Notice that when you select a path, LabVIEW normally searches that
directory, but not the directory’s subdirectories. You can make the search
hierarchical by appending a * as a new path item. For example, to search
the directory C: \VIs\ recursively, you would enter C:\VIs\* as the
path.
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The special pull-down menu, shown in the following illustration, lets you
select from several special directories.

v

4

<topvi>
<topvi>\*
<foundvi>
<foundvi>\*

<vilib?> as a path entry is a symbolic path that refers to the vi.1lib
directory inside of the Library Directory. <topvi> is a symbolic path
that refers to the directory containing the top level V1. <foundvi>
refers to a list of directories that LabVIEW creates when you open a VI.
If, during a search, you manually select a directory, that directory is
added to the list of foundvi directories. Use this symbolic path so that
if you move or rename a directory of VIs, and then open a calling V1, you
have to manually find that directory only once for that load.

You can also remove a path using the Remove button, which places the

removed path into the string box, in case you decide to re-insert it
elsewhere in the list.
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Display Preferences

You configure default colors from the display preferences dialog. You
can also configure LabVIEW to use smooth updates on all controls.

. Preferences

, Display ﬂ

: Front Panel [JUse Defauit Colors
:I Block Diagram

[:: Sciolbar

E Coercion Dots

E Menu Text

E Menu Backgiound

{JUse smooth updates during drawing

elp messages for a control are displayed here when the mouse is placed over the
control. '

I UK g Il'.‘ancelg

The Front Panel and Block Diagram colors are the default colors for
new windows. Thus, changing these parameters does not affect old VIs.
The Scrollbar color, Menu Bar colors, and Coercion Dots colors affect
all VIs that are currently open.

The Use smooth updates during drawing option lets you configure
LabVIEW to use offscreen drawing to smooth out displays. When
LabVIEW updates a control with smooth updates off, it erases the
controls contents and draws the new valuve. This can result in a noticeable
flicker as the old value is erased and replaced. Using smooth updates,
LabVIEW draws data to an offscreen buffer and then copies that image
to screen instead of erasing a section of the screen. This avoids the flicker
caused by erasing and drawing. However, it can slow performance and it
requires more application memory because an offscreen drawing buffer
has to be maintained.
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Miscellaneous Preferences

The miscellaneous page of the preferences dialog lets you configure
options for execution highlighting, configure warning levels for the error
box, edit a control using a double click, end text entry with an Enter key,
and turn Bitmap printing on by default.

[ Miscellaneous v ]

[ Show data bubbles during execution highlighting

B3 Auto probe during execution highlighting

[} Show warnings in error box

i9fam edion obiects ase partiolly fudden
[[] Open the control editor with double click
[ End text entiy with Return key {same as Enter key)

[] Print using bitmaps

i Help messages for a contiol are displayed here when the mouse ks placed over the
control.

l OK g I Cancelg

- The default selection Show data bubbles during execution
highlighting animates execution flow by drawing bubbles along the
wires. You may want to turn off this feature if it slows down performance
too much on your computer.

The default selection Auto probe during execution highlighting probes
scalar values automatically, drawing their values on the diagram. You
can turn off this feature if you find that it clutters the display.

The selection Show warnings in error box optionally displays warnings
in addition to errors. A warning does not mean that the VI is incorrect; it
Just helps by pointing out a potential problem in your diagram. One of
the warnings alerts you that there are overlapping objects. You may want
to restrict this warning to warn only about objects that are completely
hidden.
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You normally access the control editor by selecting a control and then
selecting Edit Control from the Edit menu. You can select Open the
control editor with double click so that double-clicking on a control
will open the control editor. By default, this option is turned off, because
the control editor is generally used only by advanced users.

When you enter data, the Enter key on the alphanumeric keyboard
embeds a newline in string controls. The Enter key on the numeric
keypad ends text entry. You can select End text entry with Return key
(same as Enter key) so that both keys function like the Enter key on the
numeric keypad, and end text entry. If you configure LabVIEW in this
marnner, you can embed newlines by hitting <Ctrl-Enter>.

LabVIEW supports two modes of printing—bitmap printing and non-
bitmap printing. Nonbitmap printing generally produces a higher
resolution printout. It usually requires less memory and produces
printouts faster than bitmap printing. However, due to font substitution
and the way that some printer drivers handle overlapping text and
graphics, it may not produce an image that looks exactly like what is on
the screen. Bitmap printing may produce a more accurate printout by
creating a bitmap image of the screen and sending it to the printer. Notice
that this can be more costly in terms of time and memory. Nonbitmap
printing is normally the default setting. Y ou can optionally make bitmap
printing the default using the Print using bitmaps option.
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This chapter discusses editing techniques for the front panel and the
block diagram.

When you are familiar with these techniques, see the Block Diagram
Programming part of this manual (Chapters 11 through 18) for help in
building block diagrams, and see the Front Panel Objects part (Chapters
4 through 10) for information on building front panels. This chapter
concludes with a section explaining how to edit the icon and connector.

Creating Objects

Starting with an untitled Panel window, select an object from the
Controls menu.

Boolean B (22 22 OE
String 4 '

Array & Cluster : E E"_%)z] [ing ¥ =]Enum] [o1g Ring]
Graph —

P'ath & RefNum 3 10.0-1  1.0-1 10.0-.‘ 10.0-1} 1o.¢~
Decorations > iiﬁiﬂ 31:38 iﬂ? iiﬂig ﬁiﬁl
Control...

10.0-
O SCIH 4‘=;"-_—» )Y 5.
01 1010 00 1910 010 100 0 i) 00

q

4\ " ~ I‘
GO =l ©)
o 10

LI M

The object appears in the panel window with a black or gray rectangle
representing a label. If you want to retain the label at this time, enter text

yS}
)
—~
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from the keyboard. After you enter text into 4 label, any of the following
actions completes the entry:

e Press <Shift-Enter>.
- Press <Enter> on the numeric keypad.
«  Click on the enter button in the tool palette.

«  Click outside the label.

] P v | A

File Edit Operate Controls Windows Text i \

(=] éh [+ EY [AllR](#]

+
Yaltage Input
$
= m
\
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For the purposes of this discussion, place two more objects on the front
panel from the Controls menu. To move an overlapping object, click on
the object (not its label) with the Positioning tool and drag the object to
a new location. '

B _ Untitled 1 «
File Edit Operate Controls Yindows Te:

| Zh Y (AR

0.00, 4.0 6.0
|Jonagelngud Yo
ID.UD | E-D_Iﬁ);::&}_a[l
. \l\g g{
u.u> = 0
=000 __
+
- 1+ O]
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Select Show Diagram from the Windows menu to see the terminals of
the components you just placed in the Panel window. Move terminals so
that they do not overlap.

Windows
Show Diagram' - _
Show Help Window
Show Clipboard

Tile

Size To Screen

Rbout LabUIELL...

Show U1 Hierarchy

Ihie #1'¢ £ aliers b
This #1's f afiees 4
inapaened Sublis .
Unigpened iype dafs b

v Untitled 1
Untitled 1 Diagram

, Untltled 1 Blagram R
t Operate Functions Windows Text —I

h I AR

holtage Input
FreqOerc

................

L‘.
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Selecting Objects

You must select an item hefore you can manipulate it.

To select an object, click the mouse button while the Positioning tool is
on the object. When you select an object, LabVIEW surrounds it with a
moving dashed outline called a marquee.

Not Selected Frequenc
Selected DBL ||

To se]éct more than one object, <shift>-click on each additional object.
You can also deselect a selected object by <shift>-clicking on it.

Another way to select single or multiple objects is to drag a selection
rectangle around the object(s), as shown in the following illustration.
Click in an open area with the Positioning tool and drag diagonally until
all the objects you want to select lie within or are touched by the selection
rectangle that appears. When you release the mouse button, the selection
rectangle disappears, and a marquee surrounds each selected object. You
can then move, copy, or delete the selected objects.

® @

R
;. Hem ]
: s |
Hoco ] oo ]
) +

You cannot select a front panel object and a block diagram object at the
same time. However, you can select more than one object on the same
front panel or block diagram.
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Clicking on an unselected object or clicking in an open area deselects
everything currently selected. <Shift>-clicking on an object selects or
deselects it without affecting other selected objects.

Moving Objects

You can move an object by clicking on it with the Positioning tool and
then dragging it to the desired location.

If you hold down the shift key and then drag an object, LabVIEW
restricts the direction of movement horizontally or vertically, depending
on which direction you first move the object.

You can move selected objects small, precise increments by pressing the
appropriate arrow key on the keyboard once for each pixel you want the
objects to move. Hold down the arrow keys to repeat the action.

1f you change your mind about moving an object while you are dragging,
continue to drag until the cursor is outside all open windows and the
dotted line disappears, then release the mouse button, This cancels the
move operation, and the object remains where it was. If your screen is
cluttered, the menu bar is a convenient and safe place to release the
mouse button when you want to cancel a move.

Duplicating Objects

To duplicate a LabVIEW object, sclect the object and choose Copy from
the Edit menu. Then click where you want to place the duplicate and
choose Paste. You can duplicate several objects at the same time by -
dragging a selection marquee around the items before duplicating them.

Another method of duplicating an object is cloning. which is described
in detail in your tutorial manual.

You can duplicate most objects in LabVIEW. However, you cannot
duplicate front panel control and indicator terminals in the diagram
except by copying the associated front panel control or indicator, nor can
you copy parts that are attached to a particular object.
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Copying Objects between VIs or from Other Applications

You can copy and paste objects from one VI to another or copy or cut
pictures or text from other applications to LabVIEW by using the Copy,
Cut, and Paste commands from the Edit menu. These operations place
the copy on the Clipboard. When an object is on the Clipboard, you can
paste it into another part of the current VI, another VI, or another
application. Pictures pasted into LabVIEW from other applications have
their own pop-up menus just like other LabVIEW objects.

Deleting Objects

To delete an object, select the object and choose Clear from the Edit
menu or press the backspace or delete key. Block diagram terminals for
front panel controls and indicators disappear only when you delete the
corresponding front panel controls or indicators.

Although you can delete most objects, you cannot delete control or
indicator components such as labels and digital displays. However, you
can hide these components by selecting Show from the pop-up menu and
then deselecting the Label or Digital Display options.

Labeling Objects

Labels are blocks of text that annotate components of front panels and
block diagrams. There are two kinds of labels: owned labels and free
labels. Owned labels belong to and move with a particular object and
annotate that object only. You can hide these labels but you cannot copy
or delete them independently of their owners. Free labels are not attached
to any object, and you can create, move, or dispose of them
o independently. Use them to annotate your panels and diagrams. You use
ﬁ: the Labeling tool, whose cursor is the I-beam and box cursor, to create

Labeling tool free labels or to edit either type of label.
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Creating Labels
To create a free label, select the Labeling tool from the edit mode palette
and click anywhere in empty space.
ZB): ()] [ & Al
B EI] EE
odel 704 Meter]

A small, bordered box appears with a text cursor at the left margin ready

— to accept typed input. Type the text you want to appear in the label. The

enter enter button appears on the tool palette to remind you to end text entry
by clicking on the enter button, pressing <shift-enter>, pressing <enter>
on the numeric keypad, or clicking outside the label. If you do not type
any text in the label, the label disappears as soon as you click somewhere
else.

enter button

If you place a label on a control or indicator with moving parts, such as
a meter, it will slow down screen updates and make the control or
indicator flicker. To avoid this problem, do not overlap front panel
objects with a label.

You can also copy the text of a label by selecting it with the Labeling
tool. Double-click on the text with the Labeling tool or drag the Labeling
tool across the text to highlight it. When the text is selected, choose Copy
from the Edit menu to paste a copy of the text onto the Clipboard. Now
you can highlight the text of a second label and select Paste from the
Edit menu to replace the text in the second label with the text from the
Clipboard. To create a new Jabel with the text from the Clipboard, click
on the screen with the Labeling tool where you want the new label
positioned, and select Paste from the Edit menu.

When you create a control or indicator on the front panel, a blank, owned
label accompanies it, awaiting input. The label disappears if you do not
cnter text into it before clicking clsewhere with the mouse.
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To display a hidden label, pop-up on the object and select Label from the
Show submenu of the pop-up menu, as shown below.

0.00

| Change to Indicator
Find Terminal

Data Operations Unit Label
Create Attribute Node Radiy
Replace 4
Representation >

Data Range...
Format & Precision...

The bordered label appears, waiting for typed input. The label disappears
if you do not enter text into it before clicking outside the label.

SubVIs do not have labels. They have names, which look just like
labels but which cannot be edited. Function labels, on the other hand,
are empty so that you can edit them to reflect the use of the function in
the block diagram. For example, you can use the label of an Add
Junction to document what quantities are being added, or why they are
being added at that point in the block diagram. See the note in the
Creating Descriptions section in this chapter for related information.

Changing Font, Style, Size, and Color of Text

You can change text attributes in LabVIEW using the options on the
Text menu. If you select objects or text and make a selection from this
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menu, the changes apply to everything selected. If nothing is selected,
the changes apply to the default font.

e rom

pply Font

Font | 4
Size 4
Style 4
Justify 4
Color 4

The Apply Font menu lets you choose from one of three predefined font
styles, as well as the last font used. There are three fonts: Application,
System, and Dialog. Each of these font options has an associated menu
hotkey, so you can change fonts quickly.

Rpplication Font
system Font
Oialog Font
Current Font

..................................................................

Font Style...

The Apply Font menu also has a Font Style... option which displays a
dialog box for font selection. The dialog box is quicker than the menu if
you need to make several changes at once.
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Font
Size

Align

Font Style

Application

12

Left . 4

Color

|

Editing Vis

Plain

[ Bold

[ Italic

[] Undeline
[ Stikeout
[] outline
[ Shadow

[Four score and seven years ago our forefathers brought forth
4 |upon this continent a new nation conceived in liberty and
dedicated to the proposition that all men are created equal.

|Dx §

Any font selections made from the Text menu apply to all of the objects -
in the current selection. If you select a new font while you have a knob
and a graph selected, the labels, scales, and digital displays all change to
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the new font. The following illustration shows a numeric and a Boolean
control being changed to the System font.

rlnumberl _: ;stop buttonl

“Text
- Apply Font p)

Application Font
.................................................. “System Font
gpnt : Dialog Font
1z€e Current Font
Style T
‘ Justify >
Font Style...
Calar » Y

; Inumber sﬁp buttnﬁ
o0 Jifstor]

Notice that as many font attributes as possible are preserved when you
make a change. If you change several objects to Courier font, they will
retain their size and styles if possible. In the same way, changing the size
of multiple text selections does not change the selections to the same
font. These rules do not apply if you make your changes with the Apply
Font menu, which changes the selected objects to have the selected font
and set of attributes.

When working with objects like slides, which have multiple pieces of
text, remember that text selections affect the objects or text currently
selected. If you select the slide and select Bold, then the scale, digital
display, and label all change to a bold font. If you select only the label,
then only the label changes to bold. If you select text from the scale, then
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scale markers, which must all have the same font, will change to bold as
shown in the following illustrations.

t
H |
H : ]
t -3
110.0-1 & —_—_— 110.0- A
| ’ ! [} ]
| 6.0~ : Rpply Font » | 6.0- !
[}
| 40- E L 4.0- !
P ! 20- ; Font » | 2.0- '
i , Size » : !
= ! Style - b X0 = B 3
Justify »
Siide Colar ¥ Italic d
Underline 10,0~ 2
L =
R B |- Outline 80-| |-
8.0- . Strikeout 60—
6.0- 4;_
4.0- - 2'0_
20-
0.0-E
0.0-E&
' slide
slide| 10.0—9
=] __m-
e . 80| |°
8.0- o
6.0- S .
4.0-
4.0- oo
2.0~ |
- 0.0-5
0.0-&
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Resizing Objects

You can change the size of most objects. When you move the Positioning
tool over a resizable object, resizing handles appear at the corners of the
object, as shown below.

When you pass the tool over a resizing handle, the cursor changes to the

_-ﬂ Resizing tool. Click and drag this cursor until the dashed border outlines
Resizing tool the size you want, as shown in the following illustration.
Icommand str"ingl lcommand str"ing]

ATT; TRI; FR440

T FlaT7: TR FRA40:
) i _

To cancel a resizing operation, continue dragging the frame corner
outside the window until the dotted frame disappears. Then release the
mouse button. The object maintains its original size.

Some objects can grow horizontally or vertically only. The Resizing
cursor appears the same but the dotted grow outline will move in only
one direction. To restrict growth vertically or horizontally, or to maintain
the current proportions, hold down the shift key as you click and drag.
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Resizing Labels

Resize labels as you would other objects, using the resizing handles.
Labels normally autosize; that is, the box automatically resizes to contain
the text you enter. Label text remains on one line unless you enter a
carriage return or resize the label box. Choose Size to Text from the label
pop-up menu to turn autosizing back on.

Creating Descriptions

If you want to enter a description of a LabVIEW object, such as a control
or indicator, choose Description... from the Data Operations submenu
of the object’s pop-up menu. Enter the description in the dialog box
shown below and click OK to save it. LabVIEW displays this description
whenever you subsequently choose Description... from the object’s
pOp-up menu.

Description

|Ambient temperature during calibration

Note: You cannot edit subV1 descriptions from the calling VI diagram. Y ou
‘can edit a VI description through the Get Info... selection of the File
menu when the VI's front panel is open. Function description boxes
are blank so that you can describe the action taking place at each
occurrence of that function on the block diagram.

© National Instruments Corporation 2-15 LabVIEW for Windows User Manual

DEFS 00031657
Page 70 of 460



Editing VIs : Chapter 2

Coloring Objects

LabVIEW appears on the screen in black and white, shades of gray, or

color depending on the capability of your monitor. You can change the
color of many LabVIEW objects, but not all of them. For example, block
diagram terminals of front panel objects and wires use color codes for the
type and representation of data they carry, so you cannot change them.

You cannot change colors in black and white mode.

To change the color of an object or the background screen, pop-up on it
,#"7 with the Coloring tool, as shown at the left. The following palette appears
in color.

Coloring tool

O000000000000
Foreground Background:. More...

All for both Other keys toggle

As you move through the palette while pressing the mouse button, the
object or background you are coloring redraws with the color the cursor
is currently touching. This gives you a preview of the object in the new
color. If you release the mouse button on a color, the object retains the
selected color. To cancel the coloring operation, move the cursor out of
the palette before releasing the mouse button.

- If you select the box with a T in it, LabVIEW makes the object
transparent. With this feature, you can layer objects. For instance, you
can place invisible controls on top of indicators; or you can create
numeric controls without the standard three-dimensional container.
Transparency affects only the appearance of an object. The object
responds to mouse and key operations as usual.

Some objects have both a foreground and a background that you can
color separately. The foreground color of a knob, for example, is the
main dial area, and the background color is the base color of the raised
edge. The display at the bottom of the color selection box indicates
whether you are currently coloring the foreground, the background, or
both. A black border around a square indicates that you have selected that
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square. In the default setting, both the foreground and the background are
selected.

To change between foreground and background, you can press <f> for
foreground and <b> for background. Pressing <a> for all selects both
foreground and background. Pressing any other key also toggles the
selection between foreground and background. The selection does not
toggle until you move the coloring tool.

Selecting the More option from the coloring palette calls up a dialog box
with which you can customize the colors.

Foreground and Background:

Gieen Blue

179 | (79

Each of the three color components, red, green, and blue, describes eight
bits of a 24-bit color. Therefore, each component has a range of 0 to 255.
To change the value of a color component, you can double-click in that
color’s display and enter the new value, or click on the appropriate arrow
button to increment or decrement the current value. After entering the

new value, press the enter key on the numeric keypad to see the results
in the color rectangle. To alter one of the base colors, click on the color
rectangle and choose one of the selections. The component values for the

" selected color appear in each display.
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The last color you select from the palette becomes the current color.
Clicking on an object with the Coloring tool sets that object to the current
color.

You can also duplicate the color of one object and transfer it to a second
object without going through the color palette. <Ctrl>-click with the
Coloring tool on the object whose color you want to duplicate. The
Coloring tool appears as an eye dropper and takes on the color of the
selected object. Now you can click on another object with the Coloring
tool, and that object becomes the color you chose.

Aligning and Distributing Objects

L.abVIEW has an automatic alignment mechanism, which is available
through the Alignment, Distribution, Align, and Distribute itemns in the
Edit menu.

Aligning Objects
Select the objects you want to align and choose the axis along which you
want to align them from Alignment in the Edit menu.
]
o) 0
Edit
" Poitege ) | Undo
% (ST
r Voltage out Copg
Hloco | Paste
Clear
(:) ' Remouve Bad Wires
T Panel Order...
[21Eh 0 [Allx :
Rlign- IAHE
Distribution b 3
Distribute roolffe-olillon
' o
Move Forward eft Edges
riove Backuard
Move To Back
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Choosing Align from the Edit menu uses the same axis for subsequent
alignments.

Distributing Objects
To evenly distribute objects, select the objects you want to distribute and

choose the axis along which you want to distribute them from
Distribution in the Edit menu.

=1 o
Edit]|

Hadn

Cut
Copy
Paste
Clear

Remove Bad Wires
Panel Order...

@ fllignment >
Align _

FASHCLES Distribution =N =
D]Eh & s 23 155 %..
T A<
Move Forward : ‘9‘% e"l‘h -
- Move Backward o > |Eog |leP) [P
Move To Front Top Edges
Moue To Back J
[¥oltage Out

Choosing Distribute from the Edit menu uses the same axis for
subsequent distributions.
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Moving Objects To Front, To Back, Forward, and
Backward

You can place objects on top of other objects. LabVIEW has several
commands in the Edit menu to move them relative to each other.

For example, assume you have three objects stacked on top of each other.
Object 1 is on the bottom of the stack and object 3 is on top.

¢-g__

Move To Front moves the selected object in the stack to the top. If
object 1 is selected, then object 1 moves to the top of the stack, with
object 3 under it, and object 2 on the bottom.

If object 2 is then selected, Move To Front changes the order to object 2
on top, object 1 under it, and object 3 on the bottom.

Move Forward moves the selected object one position higher in the
1 stack. So starting with the original order of object 1 on the bottom of the
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stack and object 3 on top, selecting this option for object 1 puts object 2
on the bottom, object 3 on the top, and object 1 in the middle.

Move To Back and Move Backward work similarly to Move To Front
and Move Forward except that they move items down the stack rather
than up. :

Documenting VIs with the Get Info... Option

Selecting Get Info... from the File menu displays the information dialog
box for the current V1. You can use the information dialog box to
perform the following functions.

»  Enter a description of the VI. The description window has a
scrollbar so you can edit or view lengthy descriptions.

+  Lock or unlock the VI. You can execute but not edit a locked VI.
= See alist of changes made to the VI since you last saved it.
*  View the path of the VL.

+  See how much memory the VI uses. The Size portion of the
information box displays the disk and system memory used by the
V1. (This figure applies only to the amount of memory the V1 is
using and does not reflect the memory used by any of its subVlIs.)

The memory usage is divided into space required for the front panel
and the block diagram, VI code, and data space. The memory usage
can vary widely, especially as you edit and execute the VI. The
block diagram usually requires the most memory. When you are not
editing the diagram, save the VI and close the Diagram window to
free space for more VIs. Saving and closing subVI panels also frees
memory.
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Icon and Connector

To call your VI from the block diagram of another VI, you must create
an icon and connector for it. The icon is the graphical name of the VI,
and the connector assigns controls and indicators to input and output VI
terminals. This section explains how to create and edit a VI icon and

" connector.

Creating the Icon

To create an icon, make sure you are in edit mode. Either double-click on
the icon, or pop up on the blank icon in the top right corner of the Panel
window and select Edit Icon.

Show Connector
Edit lcon 1.
Ul Setup...

L4

The following window appears.

Icon Editor ..

Black & White  Copy from

C Biack & vrrds

16 Colots

You use the tools at the left of the window to create the icon design in the
fat pixel editing area. The normal-size image of the icon appears in one
of the boxes to the right of the editing area.

Depending on the type of monitor you are using, you can design a
separate icon for display in monochrome, 16-color, and 256-color mode.
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You design and save each icon version separately. The editor defaults to
Black & White, but you can click on one of the other color options to
switch. You can copy from a color icon to a black and white icon, and
from black and white to color as well by using the Copy from buttons at
the right. '

If you design a color icon only, it will not show up in a palette menu of
the Functions menu if you place the VI in the vi . 11D directory, nor
will it be printed out or show up on a black and white monitor.
LabVIEW uses the blank black and white icon in these cases, and the
VI will appear to have a blank icon.

The tool icons to the left of the editing area perform the following
functions.

pencil Draws and erases pixel by pixel. Use the shift
key to restrict drawing to horizontal and
vertical lines.

line Draws straight lines. Use the shift key to
restrict drawing to horizontal, vertical, and
diagonal lines.

dropper Selects the foreground color from an element
in the icon. Use the shift key to select the
background color with the dropper.

fill bucket "~ Fills an outlined area with the foreground
color.
rectangle Draws a rectangular border in the foreground

color. Double-click on this tool to frame the
icon in the foreground color.

filled rectangle Draws a rectangle bordered with the
: foreground color and filled with the
background color. Double click to frame the
icon in the foreground color and fill it with
the background color.

. select Selects an area of the icon for moving,
L .
cloning, or other changes. You can select an
entire icon for copying and pasting into
another VI with this tool.
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Enters text into the icon. You can select a
different font by double clicking on this tool
icon.

!:I ~ foreground/background  Displays the current foreground and

background colors. Click on each to get a
palette from which you can choose new
colors.

Holding down the <Cul> key will temporarily change all of the tools
except the select tool to the dropper.

The buttons at the right of the editing screen perform the following
functions when you click on them.

Undo
OK

Cancel

Cancels the last operation you performed.

Saves your drawing as the VI icon and returns to
the Panel window.

Returns to the Panel window without saving any
changes.

Defining the Connector Terminal Pattern

You send data to and receive data from a subVI through the terminals in
its connector pane. You define connections by choosing the number of
terminals you want for the VI and by assigning a front panel control or
indicator to each of those terminals. Only the controls and indicators you
will use programmatically need terminals on the connector pane.

_If the connector for your VI is not already displayed in the upper right
corner of the Panel window, choose Show Connector Pane from the
icon pane pop-up menu, as shown in the following illustration. The
Diagram window does not have a connector pane.

L

File Edit O

.o Untitled 1 -

perate Controls Windows _T_x1
# ow Connecto
. Edit icon...
Hits i Batg [Batting Average] Vi Setup...
Fo.00 ] Hipoo ]
0
i+ O
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-Untitled 1. -
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The connector replaces the icon in the upper right comner of the Panel
window. LabVIEW tries to select a terminal pattern for your VI with as
many terminals on the left of the connector pane as controls on the front
panel, and as many terminals on the right of the connector pane as
indicators on the front panel.

Each of the rectangles on the connector represents a terminal area, and
you can use them either for input to or output from the V1. If you want to
use a different terminal pattern for your VI, you can select a different
pattern.
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Selecting and Modifying Terminal Patterns

To select a different terminal pattern for your VI, pop up on the connector
and choose Patterns from the pop-up menu.

Show fcon

“_‘T Patterns -
= fliscannact
- O 1 H Bisconnect Al
Rotate 90 Degrees
1 1~ ] ] 1M Flip Horizontal
s 1 | F Flip Uertical
T ]
[ (T mlo
HHTHLL HH = H
= = H o B
Rl M eR1 gl Js
— a | HH
T HTF = 5

A solid border highlights the pattern currently associated with your icon,
as shown in the previous illustration. To change the pattern, click on a
new pattern. If you choose a new pattern, any assignment of controls and
indicators to the terminals on the old connector pane is lost.

If you want to change the spatial arrangement of the connector terminal
patterns, choose one of the following commands from the connector pane
pop-up menu: Flip Horizontal, Flip Vertical, or Rotate 90 Degrees.
LabVIEW disables these items if any terminal connections exist.

Assigning Terminals to Controls and Indicators
When you decide which terminal pattern to use for your connector, you

need to assign front panel controls and indicators to the terminals. Follow
these steps.
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1. Click on a terminal of the connector. The tool automatically changes
to the Wiring tool. The terminal turns black.

— , Untitled 1 . " RAFS
File Edit Operate Controls Windows Iexﬂ%

+*

MU
H

||

2. Click on the front panel control or indicator you want to assign to the
selected terminal. A marquee frames the selected control.

File Edit Operat

(] ) v

7 f—_: B atting Ayeragel
¢ oo e Y oo

21 J

102

If you position the cursor in free space and click, the dashed line
disappeurs and the selected terminal dims, indicating that the

© National Instruments Corporation 2-27 LabVIEW for Windows User Manual

DEFS 00031669
Page 82 of 460



Eaiting Vis Chapter 2

control or indicator you selected now corresponds to the dimmed
terminal.

. @EI@@

Hits At Bats] B attingﬁ?eraqa

poo__J Hooo ]

i

Note:  Although you use the Wiring tool to assign terminals on the connector
to front panel controls and indicators, no wires are drawn between the
connector and these controls and indicators.

3. Repeat steps 1 and 2 for each control and indicator you want to
connect.

You can also select the control or indicator first and then select the
terminal. You can choose a pattern with more terminals than you need.
Unassigned terminals do not affect the operation of the VI. You can also
have more front panel controls than terminals.

The connector pane has, at most, 20 terminals. If your front panel
contains more than 20 controls and indicators that you want to use
- programmatically, group some of them into a cluster and assign the
cluster to a terminal on the connector pane.

Deleting ‘Connections

You can delete connections between terminals and their corresponding
controls or indicators individually or all at once. To delete a particular
connection, click on either the control/indicator or the terminal on the
connector pane with the Wiring tool. Then choose Disconnect from the
pop-up menu for the terminal you want to delete.
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Show Icon
Patterns »

Disconnect

Disconnect Al
Rotate 90 Degrees
Flip Horizontal
Flip Dertical

The terminal turns white, indicating that the selected connection no
longer exists. To delete all connections on the connector, choose
Disconnect All from the pop-up menu for the connector. LabVIEW also
deletes all existing connections automatically if you select a new pattern
from the Patterns palette.

Confirming Connections

To see which control or indicator is assigned to a particular terminal,
click on a control, indicator, or terminal with the Wiring tool when the
connector pane is visible. LabVIEW selects the corresponding assigned
object.
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This chapter discusses how to operate and debug VIs, explains how to set
up VIs and subVIs for special execution modes, and discusses factors
that affect execution speed.

Operating Vs

LabVIEW has two modes of operation, edit mode and run mode. You
edit and create VIs in edit mode, and you execute VIs in run mode. In edit
mode, the editing tools are available on the Panel palette below the menu
bar, as shown below.

[ [>]Eh [RIx] (Al

ﬂ When you are ready to run the VI, click on the mode button, or select

J Change to Run Mode from the Operate menu. This compiles your VI

mode button and switches you to run mode. In run mode the execution buttons appear
on the Panel palette, as shown below,

D@ SEJ [pARE

No tools are available in this palette. The Operating tool is the only tool
that functions in run mode. You use the Operating tool to enter text into
string controls, enter numbers into numeric controls, and manipulate
mechanical-action controls. You cannot edit labels, or resize or move
objects. You can only set inputs and select operating commands.

In edit mode, you use the tab key to change tools. In run mode, tabbing
selects different objects on the front panel according to panel order (the
order in which you placed them on the panel). In run mode, the pop-up
menu contains only the options for running a VI. The pop-up menu for a
control in edit mode contains a Data Operations submenu in addition to
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the editing submenus. Popping up on a control in run mode, however,
displays only the Data Operations menu as shown in the following
figure. You can cut, copy, or paste the contents of the control, set the
control to its default value, and read the control's description with options
in this menu. Some of the more complex controls have additional
options, for example the array has options with which you can copy a
range of values or go to the last element of the array.

EEI=1™ [@]ig

Lo Reinitialize to Default
Cuf Bata

Copy Data

Pasie Balp
Description...

[

The Operate menu on the menu bar contains commands for executing
the current VI. The following sections discuss several fundamental
execution-related tasks.

Running a VI
You can run a VI in edit mode or run mode by selecting the Run
l{} command from the Operate menu or by clicking on the run button. From
run button the edit mode, LabVIEW compiles the VI, switches to run mode and runs
the VI. When the VI finishes executing, LabVIEW returns you to edit
mode. While the VI is executing, the run button changes appearance.
g The VI is running at its top level if the run button changes to the VI
VI running at running at top level indicator, as shown to the left.
top level
. The VI is executing as a subVI if the run button changes to the VI caller
"5 is running indicator, as shown to the left.
Vlcaller
1S runming You can run multiple VIs at the same time. After you start the first one,
“switch to the Panel or Diagram window of the next one and start it as
described above. Notice that if you run a subVI as a top-level VI, all
caller VIs are broken until the subVI completes. You cannot run a subV1
as a top-level VI and as a subV] at the same time.
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If your VI runs but does not perform correctly, refer to the Debugging
Techniques for Executable Vs section of this chapter.

Stopping a VI

Normally, you should let a VI run until it completes. However, if you
@ need to halt execution immediately, click on the stop button or select the

stop button Stop command from the Operate menu. The Stop command aborts the
top level VI at the earliest opportunity. The halted VI most probably did
not complete its task, and you cannot rely on any data it produces.
Although LabVIEW closes files open at the time and halts any data
acquisition that may be in progress, you should avoid designing VIs that
rely on the Stop option. If you create a VI that executes indefinitely
within a While Loop until stopped by the operator, for example, control
the conditional terminal of the loop with a Boolean switch on the front
panel.

If you want to prevent an operator from inadvertently aborting your VI
by clicking on the stop button, hide it using the VI Setup... option from
the icon pane pop-up menu on the VI's Panel window.

Running a VI Repeatedly

) To execute a VI repeatedly, click on the continuous run button. The VI
CONUNUOUS TUN e oing executing immediately, and the continuous run button changes

button from outlined arrows to filled arrows while the VI is running. Click on
the continuous run button again to stop the V1. The VI stops when it has
~completed normally.
VI running
continuously The behavior of the VI and the state of the run mode palette during

continuous run is the same as during a single run started with the run
button or the Run command.

Printing Programmatically

In designing VIs, you may want to print the results of a calculation or
acquisition. You can print front panel data using the Print... option from
the File menu. However, this option is not useful if you need .
programmatic control of printing, or if you want to print only a subset of
the front panel data. :
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@ If you set the print mode button of a VI, you can set a VI to automatically

print the contents of its front panel each time it finishes execution. With
this setup for top level VIs, you can automatically log to the printer the
contents of a front panel after execution. For subVls, the front panel
prints at the end of each call.

print mode
button

If you want to print only at certain times, or if you want to print only a
subset of the information on a front panel, create a subVI with controls
for only the desired information, and set the print mode button for the
subVIL. When you want to print, call the subVI, pass it the desired data,
and LabVIEW will print the data antomatically.

For record keeping purposes, you can use the print button to print the

front panel controls and indicators when the VI executes either at the top
level or as a subV1. LabVIEW does not print the block diagram, icon, or
connector when you use this feature, called background print spooling.

5| When you click on the print button, it changes to indicate that printing is

print mode active. Click on this button at any time to disable printing.

active . . .
Printing occurs when the VI completes and updates the indicators with

new values. You do not see the standard Print dialog box, and LabVIEW
uses the print options from the Page Layout dialog box. For minimum
impact on execution performance, you should use background print
spooling.

LabVIEW saves the printing state with the VL. If background print
spooling is on in conjunction with a breakpoint suspension, LabVIEW
prints the panel when you click the Resume button.

Front Panel Datalogging

Front panel datalogging logs data to a separate file. This way you can
have several separate files, each filled with logged data from different
tests. You can also retrieve the data using standard file I/O functions.

4
- Turn automatic datalogging on for a VI by clicking on the dataloggin
datalogging button button in the executior% palitte. When autc);matic dftalogging is or%, thg
' arrow in the datalogging button darkens. Clicking on the activated
datalogging button turns automatic datalogging off.
datalogging .

activated When automatic datalogging is on, the VI automatically logs front panel
data to a file after each execution of the VI whether it is a top level VI or

a subV1. You can also log the current front panel data at any time by
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* selecting the Log... option from the Data Logging submenu of the File
menu.

Ry : P
Data Logging 3 Log...

Relvieue.,
Get Info... Purge Bala.,,
Edit DI Library... Change Log File Binding...

Clear Log File Binding

When datalogging is on, you will be prompted to select a file for the data,
either immediately when you select the Log... option, or when the VI is
run. After a file has been selected, the V1logs any further front panel data
logged to this same file.

You can change the active file by using the Change Log File Binding ...
option from the Data Logging submenu of the File menu.

Selecting Clear Log File Binding disassociates the VI from any
associated log file. The next time you log from the VI front panel, you
will be prompted to specify the log file.

To view logged data interactively, select the Retrieve... option from the
Data Logging submenu of the File menu. The execution palette changes
to the data retrieval palette, as shown in the following illustration.

exderd 170 [i ljlofo-1 12/2/92 22 -28:46.000

E You change the record number to select a specific log entry. Clicking on
- the enter button causes the panel to display the selected record. You can
mark the selected record for deletion by clicking on the delete button.

When a record is marked for deletion, the delete button changes to a full

enter button

trash can. Clicking on the full trash can unmarks the selected record for
delete button deletion. Selected records are not deleted until you select Purge Data...
from the File menu, or until you switch out of data retrieval mode, either

@ by clicking on the mode button or selecting Retrieve... from the File
record marked menu again. If any records are still marked for deletion when you switch
for deletion out of data retrieval mode, you are asked whether you want to delete the

marked records.
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Programmatic Data Retrieval

Chapter 3

You can retrieve data logged from a VI by using the standard File I/O
functions to read the file as a datalog file.

You can also retrieve data by using the Enable Database Access option
from the popup menu of a subVT that contains logged data. A halo that
looks like a file cabinet will appear around the V1. This halo has
terminals for accessing data from the V1. If you run the calling diagram,
the subVl1 does not execute. Instead, LabVIEW retrieves data from a .
specified record. It also returns the time that the data was logged, and a
Boolean value indicating whether the specified record is beyond the end

of the file.
MY EOF
DATH
PROC MY
DRTA
PROC
W ——
MY 1ime
DATA
PROC
Show

Description...
Show Terminals
Replace

Cluster Tools
Relink To SubUli
Open Front Panel
Subt/l Node Setup...
 Enable Database Access &

LabVIEW for Windows User Manual
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The following illustration shows the halo terminals for accessing the V1.

invalid

record ¥ —|
record #?

éluster of
front panel data
in panel order

(cluster of
u32 for secs since
LY reference time .
ul16 for additional
msees)

Debugging Executable VIs

The techniques discussed in this section apply only to VIs you can run.
Broken (nonfunctional) V1Is cannot compile or execute. See the
Debugging Techniques for Nonexecutable Vs section in Chapter 12,
Wiring the Block Diagram, for help in fixing broken VIs.

Correcting a VI Range Error

@ A range error indicator appears in place of the run button under the
following circurnstances.
range error
indicator *  You configured a control on a subVT to stop execution when it
receives an out-of-range value (via the control's Data Range...
option), and the control receives such a value.

*  You configured an indicator.on a subVT to stop execution when it
tries to return an out-of-range value to a calling VI, and the
indicator attempts to return such a value.

© National Instruments Corporation 3-7 LabVIEW for Windows User Manual

DEFS 00031678
Page 91 of 460



Executing VIs

Note:

Chaprer 3

+  An operator enters an out-of-range value into a control that you set
to stop execution on error, provided that the V1 is not running at the

time.

So that you can see the out-of-range control or indicator, its appearance
changes as shown below.

Ir Range

ﬂ:l ' 1'br ]ID'
0.00 5.00 10.00 |0.00 5.00 10.00
In Range Cruk of Ruange

A VI or subVI can pass out-of-range values to one of its indicators
without halting execution. The error condition exists only when a
subVI attempts to return such a value. Also, an operator can enter
out-of-range values into a control while its VI is executing. The
out-of-range error condition only prevents the VI from starting, not
Jrom continuing once it has already started.

Recognizing Undefined Data

There are two mnemonics that can appear in floating-point digital
displays to indicate faulty computations or meaningless results. NaN (not
a number) is the symbol that represents a particular floating-point value
that operations such as taking the square root of a negative number can
produce. Inf is another special floating-point value produced, for
example, by dividing by zero.

Undefined data can corrupt all subsequent operations. Floating-point
operations propagate NaN and % Inf, which, when explicitly or implicitly
converted to integers or Booleans, become meaningless valunes. For
example, dividing by zero produces Inf, but converting that value to a
word integer produces the value 32,767, which appears to be a normal
value. Before converting to integer types, check intermediate floating-
point values for validity unless you are sure that this type of error will not
occur in your VL
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Executing a For Loop zero times can produce unexpected values. For
example, the output of an initialized shift register is the initial value.
However, if you do not initialize the shift register, the output is either the
default value for the data type-0, False, or empty string—or the output is
the last value loaded into the shift register when the diagram last
executed.

Indexing beyond the bounds of an array produces the default value for
the array element data type. You can inadvertently do this in a number of
ways, such as indexing an array past the last element using a While Loop,
supplying too large a value to the index input of an Index Array function,
or supplying an empty array to an Index Array function. '

When you design VIs that may produce undefined output values for
certain input values, you should not rely on special values such as NaN
or empty arrays to identify the problem. Instead, make sure your VI
either produces an error message that identifies the problem or produces
only defined default data.

For example, if you create a VI that uses an incoming array to auto-index
a For Loop, you need to evaluate the operation of the VI if the input array
is empty. You can either produce an output error code or substitute
predefined values for the values created by the loop.

Note: A floating-point indicator or control with a range of -Infinity to
+Infinity can still generate a range error if you send NaN to it.

Debugging Techniques for Executable VIs

If your program executes but does not produce the expected results, here
are some steps to take to solve the problem:

»  Check wire paths to ensure that the wires connect to the proper
terminals. Triple-clicking on the wire with the Positioning tool
highlights the entire path. A wire that appears to emanate from one
terminal may in fact emanate from another, so look closely to see
where the end of the wire connects to the node.

»  Use the Help window (from the Windows menu) to make sure that
functions are wired correctly.

« If functions or subVlIs have unwired inputs to functions or subVIs,
verify that the default value is what you expect.
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»  Use breakpoints, execution highlighting, and single-stepping to
determine if the VI is executing as you planned. Make sure you
disable these modes when you do not want them to interfere with
performance.

»  Use the probe feature described in the Using the Probe section of
this chapter to observe intermediate data values. Also check the

error output of functions and subVlIs, especially those performin
1/0. , :

»  Observe the behavior of the VI or subVI with various input values.
For floating-point numeric controls, you can enter the values NaN
and ZInf in addition to normal values.

» If the VI runs more slowly than expected, make sure execution
highlighting is turned off in subVIs. Also, close subVI windows
when you are not using them.

»  Check the representation of your controls and indicators to see
whether you are getting overflow because you have converted a
floating-point number to an integer or an integer to a smaller
integer. Refer also to the Recognizing Undefined Data section of
this chapter.

«  Check the data range and range error action of controls and
indicators. They might not be taking the error action you want.

+  Check for For Loops that may inadvertently execute zero iterations
and produce empty arrays. Refer also to the Highlighting Execution
and Recognizing Undefined Data sections of this chapter.

»  Verify that you initialized shift registers properly, unless you
specifically intend them to save data from one execution of the loop
to another.

»  Check the order of cluster elements at the source and destination
points. Although LabVIEW detects data type and cluster size
mismatches at edit time, LabVIEW does not detect mismatches of
elements of the same type. Use the Cluster Order... option on the
cluster shell pop-up menu to check cluster order.

»  Check the node execution order. Nodes that are not connected by a
wire can execute in any order. The spatial arrangement of these
nodes does not control the order. That is, unconnected nodes do not
execute from left to right, top to bottom on the diagram like
statements do in textual languages.
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«  Unlike functions, unwired subVlIs do not generate errors while
LabVIEW is in edit mode. If you mistakenly place one on the block
diagram, the subVI will execute when the diagram does, degrading
performance and perhaps corrupting the operation. You can
inadvertently hide subVIs three ways: you can deposit one directly
on top of another node; you can decrease the size of a structure
without keeping the subVI in view; or you can place one off the
main diagram area. For the latter case, scroll the Diagram window
to its limits. Also check the inventory of subVIs used in the VI
against the three Windows menu options ([name of VI}'s Callers,
[name of VI}'s SubVlIs, and Unopened SubVIs) to determine if
any extraneous subVTs exist. The Show VI Hierarchy option can
also help. You must move or resize nodes to search for extra nodes
of a valid subVl1 if they exist.
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LabVIEW Debugging Features
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Single-Stepping through a VI

For debugging purposes, you may want to execute a block diagram node
by node.

To enable single-step mode, click on the step mode button. The symbol
changes from the flat line to the square wave. Click on this button at any
time to return to normal execution.

While the VI is running in single-step mode, the step button appears.
Click on this button each time you want to execute the next node. When
the VI finishes executing, the button disappears. If you return to normal
execution mode before the VI completes, the step button disappears and
the VI runs to completion at normal speed.

The step button affects execution only in a VI or subVI that is in single-
step mode. If a VI in single-step mode has one subVI that is also in
single-step mode and one that is in normal execution mode, the first
subVl single-steps when called but the second executes normally when
called.

Highlighting Execution

For debugging purposes, you may want to view an animation of the
execution of the VI block diagram.

To enable this mode, click on the execution highlighting button, which
changes appearance. Click on this button at any time to return to normal
view mode. You commonly use execution highlighting in conjunction
with single-step mode to gain an understanding of how data flows
through nodes. Highlighting greatly reduces the performance of a VI.

As data passes from one node to another, the movement of data is marked
by bubbles moving along the wires. In addition, in single stepping, the
next node blinks rapidly as shown in the following illustration sequence.
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You can compile the VI without single-stepping or execution
highlighting support code. This typically reduces memory requirements
and increases performance by about 1 percent each. To do this, use the
V1 Setup... option from the icon pane pop-up menu on the Panel window
and select the option to hide the buttons.

Using the Probe

The probe is a tool you can use to check intermediate values in a VI that
executes but produces questionable or unexpected results. For instance,
you may have a complicated diagram with a series of operations, any one
of which may be returning incorrect data. You could wire an indicator to
the output wire from one of the operations to display the intermediate
results, or you can use the probe. Placing an indicator on the front panel
and wiring its terminal to the block diagram is not a convenient
debugging mechanism. It is time consuming and creates unwanted items
on your front panel and block diagram that you must later delete.

The probe is similar to an indicator but is easier to use. The following
example is a simple illustration of how to access the probe. In run mode,
pop up on the wire leaving the Random Number (0-1) icon and select
Probe. The probe display, which is a floating window, appears and
flashes the values carried by the wire. You can use the probe in
conjunction with execution highlighting and single-step mode to view
values more easily. You must insert the probe before running your VIin
order to see the data.

=P R Probe ]

You cannot change data with the probe, and the probe has no effect on’

- VI execution.
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Setting Breakpoints

You may want to inspect the inputs to a subVlI before it executes.

i To set a breakpoint, click on the breakpoint button as shown at left,
anz s which changes to a button with an exclamation point as shown. When
off - on that VI is called, it will halt execution of the higher-level VI so that you
breakpoint can inspect the subVI inputs. Click on this button at any time to remove
button the breakpoint and return to normal call mode.

You can also enable and disable the breakpoint with the VI Setup...
option from the icon pane pop-up menu on the Panel window of the
subV1. The two methods are interchangeable, and with either method the
breakpoint occurs at all calls to the subVI. If a subV1 is called from two
locations in a block diagram, the breakpoint suspends execution at both
calls.

. If you want a breakpoint to suspend execution at a particular call to the
subV], set the breakpoint using the SubVI Node Setup... option from the
subVI node pop-up menu, instead of the VI Setup... option. The SubVI
Node Setup... suspends execution at that particular instance of the subVI
only.

A subV1 with a control or indicator set to stop on a range error has a
conditional breakpoint. If a range error occurs, the subV1 suspends as if
it encountered a breakpoint. If no range error occurs, the subVI1 executes
normally.

When a subVI encounters a breakpoint, its front panel opens or comes to
the foreground and remains in a suspended state. At this time, the values
on the subVI controls are the inputs passed by the calling VI, and you can
change the values if you wish. In fact, you must change them to run the
subV1 if the range error indicator is on. The subVTI's indicators display
either default values or values from the last execution of the subV1during
which its panel was open.

In the suspended state, two buttons appear on the subVI's run mode

palette:
Click on the reset button, shown on the left, to run the subV] as if it were
':% the top-level V1. You can also use the Run command in the Operate
reset button menu. When the subVI completes. the indicators display results from

that execution of the subV1. However, you can change the indicator
values if you want to return different values to the calling V1. In fact, the
suspended state is the only time you can set values on indicators. You can
rerun the subVl at the breakpoint as many times as you wish. While
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rerunning, you can return to the suspended state immediately by using
the stop button or Stop command.

1 Click on the resume button, shown at the left, when you are ready to

*- return the subVT's indicator values to the calling V1. If you click the

rssume Resume button without clicking the reset button first, the VI does not
utton

~ execute before returning.

¢

Note: You cannot set.a breakpoint at a function or structure node, although
you can encapsulate the function or structure in a subVI and suspend
execution at the subVI call.

Warnings for Overlapping Objects

If an object is either partially or completely hidden by another object,
LabVIEW generates a warning. For example, if a terminal is hidden
under the edge of a structure, or tunnels are on top of each other, a
warning message is placed in the error list box. You also get warnings if
a wire has a loop in it (a place where the wire branches and then connects
back into itself). Warnings do not prevent you from running a VI; they
are just intended 1o help you to debug potential problems in your
programs.
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Introduction to Front
Panel Objects

This chapter introduces the front panel and its two component parts,
controls and indicators.

Building the Front Panel

Controls and indicators on the front panel are the interactive input and
. output terminals of the VI. This section explains a few editing options
common to all controls and indicators.

The Controls menu on the front panel contains the following menu

options.
- Controls’

Numeric
Boolean

String

Array & Cluster
Graph

Path & BefNum
Decorations
Control...

vVvVvV VvvwVvw

*  Numeric controls are used for entering and displaying numeric
quantities.

*  Boolean controls are used for entering and displaying Boolean (that
is, True/False) values.

*  String controls are used for entering and displaying text.

*  Array and Cluster controls are used for grouping sets of data.
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*  Graph controls are used for plotting numeric data in chart or graph
form.

»  Decorations are pictures you can use to enhance the appearance of
the front panel.

»  Control... lets you choose a custom control of your own design.

When you select objects from the Controls menu, they appear on the
Panel window. You can then move the controls with the Positioning tool,
like any other LabVIEW object. Controls and indicators also have their
OWnN pop-up menus.

The Decorations item of the Controls menu offers a selection of
graphics you can use to customize front panels. These objects are for
decoration only, and do not display any data.

You can copy and paste controls and indicators from one front panel to
another by using the Copy, Cut, and Paste commands from the Edit
menu.

Importing Graphics from Other Programs

You can import graphics from other programs for use as static
backgrounds or as states in Booleans or items in ring controls. Before
you can use a picture in LabVIEW, you have to load it into the LabVIEW
clipboard. You can use the Import Picture option from the File menu to
import a graphics file into the LabVIEW clipboard. You can use Import
Picture on GIF, PCX, BMP, TARGA, TIFF, LZW, WMF, and WPG
files. To use the Import Picture option, you must have the file
lvimage.d11 installed on your system. If you copy an image directly

" from a paint program to the Windows clipboard and then switch to
LabVIEW, LabVIEW automatically imports the bitmap to the LabVIEW
clipboard. Once a picture is on the LabVIEW clipboard, you can paste it
as a static picture on your front panel, or you can use the Import Picture
option from the control editor to import it as an image representing a
value of a Boolean switch or a Pict Ring.

Common Front Panel Control and Indicator Options
When you pop up on acontrol or indicator on the front panel while in edit

mode, you get a menu like the one shown in the following illustration.
The options above the line in the pop-up menu are common to all
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controls and indicators. A few controls and indicators have only these
options in their pop-up menus.

EID.UD l[

k| Change to Indicator
Find Terminal

Show

Data Operations
Create Attribute Node
Replace 4
Representation »
Data Range...

Format & Precision...

Objects in the Controls menu are initially configured as controls or

_ indicators. For example, if you choose a toggle switch from the Boolean

palette, it appears on the front panel as a control, because a toggle switch
is usually an input device. Conversely, if you select an LED, it appears
on the front panel as an indicator, because an LED is usually an output
device. However, you can reconfigure all controls to be indicators, and
vice versa, by choosing the Change to Control or Change to Indicator
commands from the object pop-up menu. The Numeric palette contains
both a digital control and a digital indicator because you use both
frequently. The String palette also contains both a string control and a
string indicator.

The Find Terminal item of the control and indicator pop-up menus

highlights the block diagram terminal for the control or indicator. This
option is useful for identifying a particular object on a crowded block
diagram.

The Create Attribute Node item creates an attribute node for the object.
Attribute nodes are used to control various properties of the object
programmatically.

The Show submenu shows a list of the parts of a control that you can
choose to hide or show, such as the name label.

In edit mode, the pop-up menu for a control contains a Data Operations
submenu. Using items from this menu, you can cut, copy, or paste the
contents of the control, set the control to its default value, make the
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current value of the control its new default, and read or change the
control's description. You can copy the data in a control or indicator and
also paste this data into another control of the same data type. (In edit
mode, you can paste data into an indicator.) Some of the more complex
‘controls have additional options; for example, the array has options that
aliow you to copy a range of values and to show the last element of the
array.

The following illustration shows the edit mode Data Operations
submenu for a numeric control. This submenu is the only part of a
control’s pop-up menu available when the VI is in run mode.

Reinitialize to Default
Cut Dals

Copy Data

Hagte Daly
Description...

If you pop-up on a control while in run mode, you can only change the
value of a control. In run mode you cannot change most characteristics
of a control, such as its default value or description.

The Replace option of an object’s pop-up menu displays the Controls
menu palette from which you can choose a control or indicator to take the
current item's place on the front panel. The item's label and description
remain the same, as do its dataflow direction (control or indicator),
numeric representation, scale configuration, mechanical action, and its
position on the block diagram and connector pane. Wires also remain

* connected.
Dialog Controls
There are two types of dialog controls: dialog rings, which are numeric,
g Ring . .
and dialog buttons, which are Boolean.
dialog box :
The dialog controls change appearance depending upon which platform
' ‘you are using. Each appears with the color and appearance typical of that
dialog button platform. In other words, the dialog button ignores your color

specifications and appears as a two dimensional black and white oval on
the Macintosh, a three-dimensional oval gray button on the Sun, and a

three-dimensional rectangular gray button in Windows. In the same way,
the dialog ring appears as a black and white rectangle with a drop shadow
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on the Macintosh and as a flat black and white rectangle on the Sun and
in Windows.

Sun "’g

Windows ' -

Because these controls change appearance, you can create VIs with
controls that look at home on any of the computers that can run
LabVIEW. Using these controls, along with the checkmark and radio
button Booleans, simple numeric controls, simple strings, and the dialog
fonts, you can create a VI that will change appearance to match any
computer you use the VI on. By using the VI Setup options to hide the
menu bar and scroll bars and control the window behavior, you can
create VIs that look like standard dialog boxes for that computer.

Enter items into the dialog ring with the Labeling tool. Use <shift-enter>
to go to the next item you want to enter. Pressing <enter> alone only
results in a carriage return. Click outside the control or change tools to
conclude entering terms.
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Custom Controls and Type Definitions

You can customize a front panel control or indicator to make it better
suited for your application. For example, you might want to make a
Boolean switch that shows a closed valve when the switch is off and an
open valve when it is on, a slide control with its scale on the right side
instead of on the left, or a ring control with predefined text or picture
items.

You can save a control or indicator that you have customized in a
directory or VI library, just as you do with VIs. You can then use this
control on other front panels. You can also create an icon for your custom
control, and have the control's name and icon appear in the Controls
menu.

If you need the same control in many places in your VIs, you can create
a master copy of that control, called a type definition. When you make a
change to the type definition, LabVIEW can automatically update all the
VIs that use it. :

The following sections explain how to make these and other custom
alterations to LabVIEW controls.

Creating a Custom Control

Put your VI in edit mode to customize a control. Place a control that is

most like the one you want to create on the front panel. For example, to

create a slide with its scale on the right, start by placing any vertical slide
~ on the front panel.

Select the Positioning tool. Select the slide control and choose Edit
Control from the Edit menu. Edit Control is available only when a
control is selected. You can edit only one control from a panel at a time.

“Edit Contiol:-
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A window opens displaying a copy of the control. This window, shown
in the following illustration, is called a control editor, and it is titled
Control N, which is the name assigned to the control editor window until
you save it and give it a permanent name.

R - Contrel 1  ° .
File Edit Operate Controls Windows Text |

[ox] h [ EY (Al [# !I
a |

ol |- |

A control editor looks like a front panel, but it is used only for editing and
saving a single control; it has no block diagram and cannot run.

A control editor has an edit mode and a customize mode. A control editor
is in edit mode when it first opens. In edit mode you can change the size
or color of a control, and select options from its pop-up menu. In
customize mode you can change the parts of a control individually.
Customize mode is described in detail later in this chapter.

After you have edited a control, you can use it in place of the original
control on the front panel that you were building when you opened the
control editor. You can also save it to use on other front panels.

Applying Changes from a Custom Control

.Y

‘*j' When want to replace the original front panel control with your new
custom control select Apply Changes from the File menu of the control
editor.
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New
Open...

Close

Apply Changes . |

When you select Apply Changes, the following question appears:
Replace the original control <name> in <VI name>
with Control Nz Click onthe Replace button to replace the original
control with your custom control. Click the No button to cancel the
replacement.

If your original front panel is the only place you will use the custom
control, you can close the control editor window without saving the
control. Be sure to save the original VI with the custom control in place
to preserve your work. If you want to use the custom control on other
front panels in the future, you must save it as described in the Saving a
Custom Control section of this chapter.

Apply Changes is only available after you make changes to the control.
Apply Changes is disabled if there is no original control to update. This
happens when you delete or replace the original control, when you close
the original front panel, or when you have opened a custom control that
you saved earlier by selecting Open from the File menu.

@ If the control editor has more than one control in it, the not-OK button
appears. A valid custom control must be a single control, though it may
not-OK button be a cluster of other controls. The Not-OK button may appear

temporarily while you move controls in and out of a cluster or array. To
get an explanation for the error, click on the Not-OK button. If there is
more than one control in the control editor the error message reads
There are extra objects on the front panel that
do not belong to the custom control.If there are no
controls the error message reads There must be one control
on the front panel for a custom control to be
valid. If you try to put a type definition control on the front panel of
the control editor, the error message reads You may not use a
Type Definition in the control editor unless it
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is inside another control, such as a cluster or
array.

Saving a Custom Control

If you want to use your custom control on other front panels, choose Save
from the File menu in the control editor window. You save a control the
same way you save a VI, in a directory or in a VI library. A directory or
VI library may contain controls, VIs, or both.

If you close the control editor window without saving your changes to the
control, a dialog box will ask you if you want to save the control.

Using a Custom Control

When you save your custom control, you can use it on other front panels
by selecting Control... from the Controls menu on the front panel of any
V1. Use the dialog box that appears to choose your control from the
directory list and place it on your front panel.

Adding a Custom Control to the Controls Menu

Noteé:

For easier access to custom controls, save them in a directory or a VI
library inside a . 1ib directory located in the LabVIEW library
directory. By default, the LabVIEW library directory is the directory
where LabVIEW is located.

Do not save your controls in the vi.lib directory. This directory is
updated by National Instruments as needed during new version
releases of LabVIEW. Placing controls in vi.11ib risks creating a
conflict during future installations. Place controls in .11ib directories
in the LabVIEW library directory with, but not inside, the vi.1lib
directory.

When you launch LabVIEW, LabVIEW looks at the contents of all

. 1ib directories in the library directory. If any of the subdirectories or
V1 libraries contain controls, LabVIEW creates a palette for those
controls and adds it to the Controls menu. You can then select your
custom controls directly from the Controls menu.

You can have both custom controls and VIs inside
your subdirectories or VI libraries. LabVIEW will display the controls
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on a palette accessible from the Controls menu of the front panel, and
the VIs on a palette accessible from the Functions menu of the block
diagram.

Your controls must be in a directory or a VI library within the . 1ib
directory. LabVIEW will not display an individual control on a palette if
it is saved directly into the . 1ib directory.

Making an Icon

L

If you save your controls so that they appear in the Controls menu, you
10.0- should make an icon representing the control before you save it. Pop up
5.0, or double click on the blank icon square in the top right corner of the

9.0-~ control editor window to create an icon for the control. This icon
control icon represents the control in the palette menu when you save the control in a

library directory.

Custom Controls are Independent from Source File

You can open any custom control you have saved by selecting Open
from the File menu. A custom control will always open in a control editor
window.

Changes you make to a custom control when you open it do not
necessarily affect VIs that are already using that control. When you use
a custom control on a front panel, there is no connection between that
instance of the custom control to the file or VI library where it is saved;
each instance is a separate, independent copy.

You can, however, create a connection between control instances on
various VI front panels and the master copy of the control. To do this,
you must save the custom control as a type definition or a strict type
definition. Then, any changes you make to the master copy affect all
instances of the control in all the VIs in which you use it. See the Type
Definition section at the end of this chapter for more information.

Customize Mode

You can make more extensive changes to a control in the customize
mode of the control editor. Change between edit and customize mode by
clicking on the mode button, or by selecting Change to Customize
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Mode or Change to Edit Mode from the Operate menu as shown in the
following illustrations.

% — @

edit mode or customize mode -

R
KEEEE:
- Change to Customize Mode

Make Current Ualues Default
Beinitialize Al To Default

Independent Parts

All LabVIEW controls are built from smaller parts. A slide control
consists of a scale, a housing, a slider, the increment and decrement
arrows, a digital display, and a name label. The parts of a shde are
pictured in the following illustration.

& |sh‘de|

Housing 10.0~ Scale

0-7 Name Label 1
i @ ~ Digital 75
75" u ‘Display '
5.0~ _(:_j Slider 50~
2.5- ' A Increment Arrow 25-
D.D—i?] < Decrement Arrow U 0.0-

When you switch to customize mode in a control editor, the parts of your
control become independent. You can make changes to each part without
affecting any other part. For example, when you click and drag on the
slide's scale with the placement tool, only the scale will move. You can
select parts and align or distribute them using Align or Distribute from
the Edit menu; or change their layering order by selecting Move
Forward or Move Backward from the Edit menu. Customize mode
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shows all parts of the control, ihc]uding any that were hidden in edit
mode, such as a name label or the radix on a digital control,

Because the parts of a control are detached from each other, you cannot
operate or change the value of the control while in customize mode.
Notice that the Operate tool is disabled.

Rzl » BENE AP

The wiring tool is always disabled in a control editor.

The Control Editor Parts Window

When you are in customize mode, you can select Show Parts Window
from the Windows menu. The floating window that appears identifies
the parts of the control, and shows you the exact position and size of each
part. The current part display in the parts window shows you a picture
and the name of the part currently selected in your control editor window.
You can see a menu of all the parts by clicking on the current part
display. You can also scroll through the parts of the control by clicking
on the current part display increment or decrement arrow. When you
change the part shown in the current part display, that part is selected on
the control in the control editor window. When you select, ch ange, or pop
up on another part of the control in the control editor window, the part
showing in the current part display also changes.

The illustration below shows the control editor window on the left
overlaid by the parts window on the right. The slide's name label is the
. current part, and is selected in the control editor window. The parts
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window shows the menu of parts that you get when you click on the
current part display.

Current Part

e
N.

| =k

Scale

[Name Label

Part Position and Dimensions

Top[@5_] Heignt[Ti_)
Left[63 | wWidth[24 ]

The parts window shows you the exact position and size of the part
shown in the current part display. These values are pixel values. When
you move or resize a part in the control editor, the position and size in the
parts window are updated. You can also enter the position and size values
directly in the parts window to move or resize the part in the control
editor. This is useful when you need to make two parts exactly the same
size, or align one part with another. In the illustration above the parts
window displays the position and size of the slide's name label: the upper
left corner of the label is at the pixel coordinates (45,63), and the label is -
14 pixels high by 24 pixels wide.

The parts window disappears if you switch to some other window. The
parts window reappears when you return to the control editor.

Pop-up Menus for Different Parts in Customize Mode

In customize mode, the pop-up menu for the control as a whole is
replaced by a pop-up menu for each part. When you pop up on a part, you
get a menu with some options available in edit mode, and some options
available only in customnize mode. Different parts have different pop-up
menus.
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There are three basic kinds of parts. Cosmetic parts, such as the slide
housing, slider, increment and decrement arrows, are the most common.
Cosmetic parts show a picture. :

The second kind of part is a text part, such as the slide's name label. Text
parts show a picture used as the background, usually just a rectangle, and
some text.

Finally, a part may be another control. The slide, for instance, uses a
numeric control for a digital display. Knobs, meters, and charts also use
a numeric control for a digital display. Some controls are even more
complicated than that: the graph uses an array of clusters for its cursor

~ display part, for instance.

The following sections describe the different parts and their pop-up
options in more detail.

Cosmetic Parts

A cosmetic part is a picture. The following illustration shows a pop-up
menu for a cosmetic part, such as a slide housing. To pop up on a
cosmetic part, you must be in customize mode. You must pop up on the
part itself, not on the picture of the part in the parts window.

Copy to Clipboard
Import Picture
Import at Same Size
Revert

1 dviginad Sioe

Copy to Clipboard puts a copy of the part’s picture on the clipboard. If
you select Copy to Clipboard for the slide housing, the clipboard
contains a picture of a tall, narrow inset rectangle. This clipboard picture
can be pasted onto any front panel or imported as the picture for another
part using Import Picture. These pictures are just like the Decorations
in the Controls... menu.

When you need simple shapes like the housing rectangle for other parts,
there are several advantages to using pictures copied from original
LabVIEW parts, instead of making them in a paint program. Pictures
taken from LabVIEW parts or decorations look better than pictures made
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in a paint program when you change their size. For example, a rectangle
drawn in a paint program can only grow uniformly, enlarging its area but
also making its border thicker. A rectangle copied from a part like the
slide housing keeps the same thin border when resized.

Another advantage is that LabVIEW parts appear correctly on both color
and black and white monitors.

Finally, you can color pictures taken from LabVIEW parts or decoration
with the LabVIEW coloring tool. Pictures imported from another source
keep the colors they were imported with, because those colors are a part
of the definition of that picture.

Import Picture and Import at Same Size replace a cosmetic part's
current picture with whatever picture is on the clipboard. Use these
options to individually customize the appearance of your controls, by
importing pictures of an open.and closed valve for a Boolean switch, for
example.

Import at Same Size replaces the current picture, but keeps the picture's
old size, shrinking or enlarging the clipboard picture to fit. If there is no
picture on the clipboard, both Tmport Picture and Import at Same Size
are disabled.

Revert restores the part to its original appearance. Revert does not
change the part's position. If you opened the control editor window by
selecting Edit Control from a front panel, LabVIEW reverts the part to
the way it looks on that front panel. If you opened the control editor
window by selecting Open from the File menu, Revert is disabled.

Original Size sets a part’s picture to its original size. This is useful for
pictures that you imported from other applications and then resized.
Some of these pictures don’t look as good as the original when resized,
and you might want to restore their original size to fix them. If you have
not imported a picture, Original Size is disabled.

Cosmetic Parts with More than One Picture

Some cosmetic parts have more than one picture, which they show at
different times. These different pictures are all the same size and use the
same colors. For example, the slide's increment arrow is a picture of a
triangle, normally raised slightly from the background. It also has
another picture, a recessed triangle, that shows while you are clicking on
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it with the Operate tool to increment the slide's value. The picture below
shows the two pictures of an increment arrow in action.

100-5> 10.0—@

75- 75-

5.0- 50- |
<]

2.5- 25-

O.Dﬁg 00-2

A cosmetic part with more than one picture has the Picture Item option
on its pop-up menu, as shown below.

Copy to Clipboard
impord Piciure
fmpart af Same §ize
Revert
Byiainat séze

o Picture Item- ' -« -

Picture Item shows all the pictures a cosmetic part has. The picture that
is currently showing has a dark border around it. When you import a

‘ picture, you change only the current picture item. To import a picture for
one of the other picture items, first select that picture item and then
import the new picture.

Cosmetic Parts with Independent Pictures
A cosmetic part with more than one picture can have different sized

pictures that each use different colors. The slide, for example, uses two
different sized pictures to show which slider is active on a multi-value
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slide. The slide in the following example uses a bigger triangle to show
that the middle slider is the active one.

100-17 Boo ]
75-

| [500 ]
50— ‘
25~
0oo-Y

A Boolean switch also has more than one picture, and each picture may

-be a different size and have different colors. The first picture shows the
False state; the second shows the True state; the third shows the transition
state from True to False when the mechanical action Switch/Latch
When Released is in effect; and the fourth shows the transition from
False to True. In the illustration below, the last two pictures just happen
to be the same.

1: False 2: True 3: T—»F 4: F—»T

You can also import pictures for a Boolean while in the control editor
edit mode by using the edit-mode pop-up menu. You can import a picture
for the False state, changing the first and third pictures, or for the True
state, changing the second and fourth pictures.
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When a cosmetic part can have different sized pictures, the part has the
Independent Sizes option on its pop-up menu, as shown below.

<

Copy to Clipboard
Impart Picture
Import at Same Size
Revert .
driginal Size
Picture ltem 4
-+ Independent Sizes

Independent Sizes is an option you can turn on if you want to move and
resize each picture individually without changing the cosmetic part's
other pictures. Normally, this option is not checked. When you move or
resize the cosmetic part's current picture, its other pictures also move the
same amount or change size proportionally.

Text Parts
A text part is a picture with some text. The pop-up menu for a text part,
such as a name label, has some items identical to those on a cosmetic
part's pop-up menu. The other items on this menu are the same as the text
pop-up menu in front panel edit mode.
|s]ﬁ' | -
Copy to Clipboard
Import Picture
Import at Same Size
Revert
griginal Size
v Size to Text
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Scale Parts

A scale is a special kind of text part with markers for the text. The scale's
picture is the background for each of its markers. This background is
usually a transparent rectangle and therefore not visible, but you can see
it if you color one of the scale markers. A scale has the same options on
its pop-up menu as a text part, along with other options relating only to
scales.

10.0
a3

8.0

Copy to Clipboard

6.0 Import Picture

4q Import at Same Size
Revert

Briginal Size *

08 Format & Precision...
Style

Mapping

Flip Scale

24

wvw

Flip Scale changes the tick marks on a vertical scale from the right side
to the left, or vice versa. On a horizontal scale, it changes the tick marks
from the top to the bottom, or vice versa. On a rotary scale, such as the
scale on a knob, dial, gauge or meter, it changes the tick marks from the
outside to the inside, or vice versa. Flip Scale does not move the scale.

You can position the scale by dragging it while in customize mode. Hold
the shift key down when dragging a scale to restrict the movement to one
direction only.

Controls as Parts

A control can include other controls as parts. A common example of this
is the digital display on a slide, knob, meter, or chart. There is no
difference between the digital display and the ordinary, front-panel
digital control, except that the digital display is serving as part of another
control.
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The digital display is also made up of parts. When you are editing the
original control in the control editor, the digital display behaves as a
single part, so you cannot change or move its parts individually. You can,
however, open a control editor for the digital display and customize it
there.

To customize a control that is a part of another control, open a control
editor for it. You can open a control editor window for the part directly
from the original front panel, if it can be selected separately from the
main control in edit mode. The digital display can be selected separately
from the slide control, for instance. Then you can choose Edit Control
from the Edit menu.

You can always open a control editor window for the part from the
control editor window of the main control. Select the part in the control
editor and choose Edit Control. Control editors can be nested in this way
indefinitely, but most controls use other controls as parts only at the top
level. An exception is the graph, which uses complicated controls as
parts, which, in turn use other controls as parts.

You cannot open a second control editor window for the main control
already being customized.

The foilowing figure shows the control editor for the slide on the left, and
a control editor window for the digital display on the right, You do not
have to be in customize mode to open a nested control editor window.

W@ [ HEEN A7
10.0-“/

75~
S.0-

[4]}]

25~
0.0-
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Adding Cosmetic Parts to a Custom Control
When you are making a custom control in the control editor, you can add
cosmetic or text parts to it to make it even more distinctive.

If you paste a picture or text from the clipboard, create a label with the
labeling tool, or select a picture from the Decorations menu, that picture
or text becomes a part of your control and appears with the control when
you place it on front panels. You can do this in either edit or customize
mode in the control editor. You can move, resize, or change the layering
order of the new part, just like any other part. Your addition appears as a
decoration part in the parts window in customize mode.

You can also delete decoration parts while you are in the control editor.

The illustration below shows a custom graph that has some decoration
parts, including the Title of Graph label, the Legend: label, and the box -
around the legend parts.

4 -
Title of Graph )

10.0-

(Legend: )
8.0 .

Signal  L—~——
6.0 Baseline f.. ., e,
4.0

- EOEE
' FOEE

0-0 TITT VI T T I I eI T N[O I Y YV T V[ vV YT TV T IS T I v T

0.0 100.0

Y

Type Definitions

In addition to using the control editor to customize the appearance of a
control, you can also use it to create a master copy of a control, called a
type definition. Type definitions are useful where the same kind of
control is used in many Vls. You can save the control as a type definition,
and use that type definition in all your VIs. Then, if you need to change
that control, you can update the single type definition file instead of
updating the control in every VI that uses it.
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Type Definition: Data types must match

A type definition forces the control data type to be the same everywhere
it is used. Use a type definition when you want to use a control of the
same data type in many places and when you may want to change that
data type automatically everywhere it is used. For example, suppose you
make a type definition from a double-precision digital control, and that
you subsequently use that type definition in many different VlIs. Later
you change the type definition to a 16-bit integer digital control.
LabVIEW will automatically update every VI that uses that type
definition, or if you prefer, indicate to you that the type definition in a VI
needs to be updated.

You can also make a type definition that is a cluster, such as a cluster of
two integers and a string. If you change that type definition to a cluster

of two integers and two strings, LabVIEW will update the type definition
everywhere it is used.

Strict Type Definition: Everything must match

A type definition can also force everything about the control to be
* 1dentical everywhere it is used, not just its data type but also its size,
color, and appearance. This is called a strict type definition.

As an example, suppose you make a strict type definition that is a
double-precision digital control with a red frame. Like the type
definition, if you change the strict type definition to an integer,
LabVIEW will automatically update every VI that uses it, or indicate that
they need to be updated. Unlike the type definition, however, other
changes 1o the strict type definition, such as changing the red frame color
to blue, also requires VIs using it to be updated.

Making a Type Definition

You make a type definition by saving a control in a control editor
window. Set up the control the way you want it, and choose Save from
the KFile menu in the control editor window. Check the box marked Save
Control as Type Definition in the dialog box before saving your
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control. To make a strict type definition, also check the box marked Save
as Strict Type Definition. '

[<J Save Control as Type Definition
Dd Save as Strict Type Definition

You can open any type definition you have saved by selecting Open
from the File menu. A type definition will always open in a control editor
window. Any changes you make to a type definition affects all VIs that
are using it.

Using a Type Definition

Place type definitions and strict type definitions on the front panel of a
VI as you would any custom control. You can edit and operate a type
definition on your front panel as you would any other control. When you
use a strict type definition on your front panel, however, you cannot edit
it in any way, except to give it a name.

You can only tell that a control is a type definition when you see the type
definition options in its pop-up menu, as shown below. You can easily
recognize a strict type definition on your front panel, because you cannot
edit it, and most of its pop-up menu options are missing.

Hpdals from Type 8ef,
v Auto-Update Type Def.
Disconnect from Type Def.

For each type definition that you use on a front panel, LabVIEW keeps a
connection to the file or VI library in which it is saved. You can see this
connection in action if you place a type definition on a front panel and
then select it and choose Edit Control from the Edit menu. The control
editor that opens is the type definition you saved, with the name you gave
it, instead of the generic Control V.
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Automatic Updating

LabVIEW ensures that the data type is the same everywhere a type
definition is used, and that everything about a strict type definition is the
same everywhere it is used. LabVIEW automatically updates any type
definitions or strict type definitions on your front panel that are incorrect,
replacing the one on your front panel with the one saved in the file or V1

library.

If you have edited an instance of a type definition on your front panel
extensively, such as coloring and resizing it, you might not want this
automatic update feature. You can pop-up on the type definition on your
front panel and turn off the Auto-Update from Type Def. option.
Instead of automatically updating this type definition when nebessary,
the VI will have a broken Run arrow and the type definition on the front
panel will be disabled. You cannot run the VI until you fix the type
definition, either by selecting the option Update from Type Def. from

~ the pop-up menu, or by changing the data type to match the type
definition.

Searching for a Type Definition

Because LabVIEW must keep a connection to the type definition, the file
or VI library containing the type definition must be available in order to
run a VI using it. If youopen a VI and LabVIEW cannot find a type
definition that the VI needs, the type definition control on the front panel
will be disabled and the Run arrow will be broken. To fix this problem,
you must either find and open the correct type definition, or pop-up on
the disabled control and select Disconnect From Type Def.
Disconnecting from the type definition removes the restrictions on the
control's data type and appearance, making it into an ordinary control.
You cannot re-establish that connection unless you find the type
definition and replace the control with it.

Cluster Type Definitions

If you use a type definition or strict type definition that is a cluster, use
the Bundle by Name and Unbundle by Name functions on the block
diagram to access the cluster's elements, instead of the Bundle and
Unbundle functions. These functions reference elements of the cluster by
name instead of by cluster order, and are not affected when you reorder
the elements or add new elements to the cluster type definition. If you
delete an element that you are referencing in Bundle by Name or
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UnBundle by Name, you will have to change your block diagram. Refer
- to the description of these functions in Chapter 8, Array and Cluster
Conitrols and Indicators, for more information.
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Numeric Controls and
Indicators

This chapter explains how to edit and operate numeric controls and
indicators. The first section introduces numeric objects, and subsequent
sections describe the features of the different styles of numeric controls
and indicators.

When you select Numeric from the Controls menu, a palette of controls
and indicators appears. As you move the selection arrow over an object
on the palette, a solid rectangular border surrounds the selected object,
and the name of the object appears at the bottom of the palette.

hd V¥
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Path & RefNum
Decorations
Control...

Controls
Numeric
h

Airray & Cluster

Siing]
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Digital Control

In the above example, the digital control is selected. If you release the
mouse button at this point, a digital control appears on the front panel,
and a corresponding terminal will appear in the block diagram. Numeric
controls and indicators are either digital, slide, rotary, ring, enumerated,
color box, or color ramp controls. Block diagram terminals are described
in Chapter 11, Introduction to the Block Diagram.

@ Nationul Instruments Corporation

5-1

LabVIEW for Windows User Manual -

DEFS 00031715
Page 128 of 460



Numeric Controls and Indicators . Chapter 5

Digital Controls and Indicators

A digital numeric control and indicator are shown below.

digital control [digital indicator]|
[

Digital numerics are the simplest way to enter and display numeric data

E112

in LabVIEW.
You can click inside the digital display window with the Operating tool
{'n, and then enter numbers from the keyboard, or you can click on the
Overating tool increment arrows with the Operating tool to increment or decrement the
P ° displayed value.

The enter button appears on the tools palette to remind you that the new
gﬁr value replaces the old only when you press the enter key on the numeric
keyboard, click outside the display window, or click the enter button.
‘While the VI is running, this prevents LabVIEW from interpreting
intermediate values as input. For example, while changing a value in the
digital display to 135, you do not want the VItoreceive the values 1 and
13 before getting 135. This does not apply to values you change using
the increment/decrement arrows.

enter button -

Further, numeric controls accept only decimal digits, a decimal point, +,
-, uppercase or lowercase e, and the terms Inf (infinity) and NaN (not
a number). If you exceed the limit for the selected representation,
LabVIEW coerces the number to the natural limit. For example, if you
enter 1234 into a control set for byte integers, LabVIEW coerces the
number to 127. If you incorrectly enter non-numeric values such as aNN
for NaN, or I£n for Inf, LabVIEW ignores them and uses the previous
value.

The increment buttons usually change the ones digit. Incrementing a
digit beyond 9 or decrementing below 0 affects the appropniate adjacent
digit. Incrementing and decrementing repeats automatically. If you click
on an increment button and hold the mouse button down, the display
increments or decrements repeatedly. If you hold the shift key down
while incrementing repeatedly, the size of the increment increases by
successively higher orders of magnitude. For example, by ones, then by
tens, then by hundreds, and so on. As the range limit approaches, the
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increment decreases by orders of magnitude, slowing down to normal as
the value reaches the limit.

To increment a digital display by a digit other than the ones digit, use the
Operating tool to place the insertion point to the right of the target digit.
When you are finished, the ones digit again becomes the increment digit.

Numbers may become too large to fit in the digital display on the control.
You can view the complete value by resizing the control, making it
longer horizontally.

Digital Numeric Options

You can change the defaults for digital numerics through their pop-up
memis. The pop-up menu for a digital numeric is shown in the following
illustration.

Change to Indicator
Find Terminal

Show 4
Data Operations 4
Create Attribute Node

Replace »
Representation 4

Data Range...
For_mat & Precision...

Displaying Integers in Other Radixes
You can display signed or unsigned integer data in hexadecimal, octal,

and binary form, in addition to decimal form. To change the form, select
Show Radix from the Show submenu of the numeric pop-up menu. A d
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appears on the housing of the numeric display as shown in the following
illustration.

digital control

Ootad
Bnary |

If you click on the d, the menu shown in the previous illustration appears.
The number 32,753 is displayed in each radix in the following

illustration.
[digital control - decimall [digital control - octal]
Haf[z2753 || q-[F77s1
[digital control -hexadecimal] _[digital control - binary]
=“Niad b[111111111110001 l|

Changing the Representation of Numeric Values

You can choose from 12 representations for a digital numeric control or
indicator. Use the Representation option from the control or indicator
pop-up menu to change 10 32-bit single-precision (SGL), extended-
precision (EXT) floating-point numbers, or one of the six integer
representations: signed (I8) or unsigned (U8) byte (8-bit), signed (116) or
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unsigned (U16) word (16-bit), or signed (132) or unsigned (U32) long
(32-bit) integers.

Change to Indicator
Find Terminal

- Show 4
Data Operations 4
Create Attribute Node

>

_ Replace »|[[EXT |[DBL |[S6L

2 e
Representation . IiE [ 18
Data Range... 3L 0|05 off .20

Format & Precision...

You can also choose complex extended-precision (CXT), complex
double-precision (CDB), or complex single-precision (CSG)
floating-point numbers.

Setting the Range Options of Numeric Controls and Indicators

Each representation has natural minimum and maximum range limits.
For example, signed byte integers are limited to values from -128
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through 127, whereas floating-point numbers have the ranges shown in
the following table.

Table 5-1. Range Options of Numeric Controls and Indicators

Precision Single Double Extended

(platform-
dependent)

Maximum 3.4E38 1.7E308 1.1E4932

Positive

Number

Minimum 1.5E-45 5.0E-324 1.9E-4951

Positive

Number

Minimum -1.5E-45 5.0E-324 -1.9E-4951

Negative

Number

Maximum -3.4E38 -1.7E308 -1.1E4932

Negative

Number

)

Note.: Although LabVIEW can process in the range shown above, the range
of extended floating-point numbers it can represent and display in text
format is 19.9999999999999999E999.
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You can choose other limits within these natural bounds with the Data
Range... option from the pop-up menu. The following dialog box
appears. '

Untitled 2

Representation

DBL Minimum |-Inf ]

Double Piecision

Maximum {int |

Increment [0.00E+0 |

If Value is Out of Range: .
r lgnore v—l Default [D.00E+0 |

Numeric Range Checking

You can also limit intermediate values to certain increments. For
example, you might limit word integers to increments of 10, or single-
precision floating-point numbers to increments of 0.25. If you change
either the limits or the increment, you should also decide what todo if a
VI or the operator attempts to set a value outside the range or off the
increment. You have the following options.

Ignore LabVIEW does not change or flag invalid values.
Clicking on the increment and decrement arrows
changes the value by the increment you set, but
the value will not go beyond the minimum or
maximum values.

Coerce LabVIEW changes invalid values to the nearest
valid value automatically. For example, if the
minimum is 3, the maximum is 10, and the
increment is 2, valid values are 3, 5, 7, 9, and 10.
LabVIEW coerces the value 0 to 3, the value 6 to
7, and the value 100 to 10.

Suspend LabVIEW suspends execution of a VI or subVI
‘ when a value is invalid. However, Vls do not
suspend in the middle of execution; they suspend
only just before or just after a VI runs. When you
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choose to suspend on invalid values, LabVIEW
keeps a copy of all the front panel data in
memory in case you need to open the front panel
to show an error.

If the value of a control is invalid before a VI runs (either before you click

. on the Run button on a top-level VI, or when a subVI is about to execute),
the VI is suspended. A suspended VI behaves as if there were a
breakpoint at the beginning of that subVI. The front panel of the VI opens
(or becomes the active window) and the invalid control(s) are outlined in
red (or a thick black line in black and white). The run mode palette of a
suspended subV1 looks like the following illustration.

Sl EM

You must set the control to a valid value before you can proceed. When
all control values are valid, the run mode palette looks like the following
illustration, and you can click on the Retry button and then on the
Resume button to continue execution.

Retry—Y Resume

button o button

If the value of an indicator is invalid when a subVI finishes running, or
if an indicator was invalid at any time while the subVI was running,
execution pauses as if there were a breakpoint at the end of that VI. The
front panel of the VI opens (or becomes the active window) and the

* indicator(s) that are currently invalid are outlined in red (or a thick black
line in black and white). The run mode palette of the suspended subVI
looks like the following illustration.

RIS

You must set the indicator to a valid value before you can proceed. In this
situation, you can enter values directly into the indicator. You can also
change the control values to produce valid outputs and run the subVI
again by clicking the Retry button. When all indicator values are valid,
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the run mode palette looks like the following illustration, and you can
click on the Resume button to continue execution.

=L

Changing the Format and Precision of Digital Displays

In their default settings, digital displays have two digits of fractional

precision. That is, they display two digits to the right of the decimal

point. You can change the precision for displays to be 0 through 20

digits. The precision you select affects only the display of the value; the
" internal accuracy still depends on the representation.

You can change the notation from decimal to scientific or engineering as
shown in the following illustration.

S{35.7000 | HE570000E 1] [35.700E 40 |

Floating-point notation Scientific Notation Engineering Notation
4 Digits of Precision 6 Digits of Precision 3 Digits of Precision
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To change either of these parameters of the digital display, use the dialog
box shown in the folowing illustration, which appears when you select
the Format & Precision... option from the display pop-up menu.

R adix: '

@ Floating Point Notation
(O Scientific Notation
(O Engineering Notation

E xample:
3.14

The display updates after you click in the OK button.

LabVIEW for Windows User Manual 5-10 © National Instruments Corporation

DEFS 00031724
Page 137 of 460



Chapter 5 , Numeric Controls and Indicators

Slide Numeric Controls and Indicators

The slide controls and indicators are shown in the following illustration.

~ [Gimple Vertica) Siide ~ [Vertica Stide] o [vertical Pointer Side]

10.00-

i

10.00- I~ 1000- A @
Fel5.00 ] a1 |
8.00- 8.00- 8.00-
6.00- 6.00- 6.00-
4.00- 4.00- 4.00- ,
2,00~ 200~ 2.00~
. 000-% ’ 000-% 0.00- &
lSimEle Horizontal Slidel Horizontal Slide [Herizontal Pointer Stide]
Hooo ] sz ] Habss ]
4 |4 qrC T v dr —y—— 1=
1

) ] 1 [ 1 | 1 !
0.00 5.00 10.00 0.00 5.00 10.00 0.00 2.00 10.00

10,002 vertical Fill Slide o [TaK
00-MeE 1000-\ W 10.00- ~
Blekor ] (|BBoe ] - M|
8.00- 8.00- 8.00~
6.00~ 6.00~ 6.00~
4.00- 4.00~ 4.00~
2.00- '2.00- 2.00-
0.00-3% ono—& ' 0.00-
Horizontal Fill Stide
Hale.33 |
I
i 1 1
0.00 5.00 10.00

Each slide has a digital display. You can use the digital displays to enter
data into slide controls, as explained in the Digital Controls and

Indicators section of this chapter. You can use the Operating tool on such
parts as the slider, the slide housing, the scale, and increment buttons to
enter data or change values. The slider is the part that moves to show the
control's value. The housing is the non-moving part that the slider moves
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on or over. The scale indicates the value of the slider, and the increment
buttons are small triangles at either end of the housing.

Hils.os |
4 10 ]t
1 } I
0.00 so5? 1000

You can drag the slider with the Operating tool to a new position. If the
V1 is running during the change, intermediate values may pass to the
program, depending on how often the VI reads the control.

You also can click on a point on the housing and the slider will snap to
that location as shown in the following illustrations. Intermediate values
will not pass to the program.

OfEz=] @EE
] — I | o 1 1>
I 1 o I I I
D.DO#""’ 5.00 10.00 0.00 ﬂh’ 5.00 10.00

If you use a slide that has increment buttons, you can click on an
increment button, as shown below, and the slider will move slowly in the
direction of the arrow. Hold down the shift key to move the slider faster.
Intermediate values may pass Lo the program.

d|7.92 l

d{ il %
I I

0.00 2.00 10.

Just like the digital numerics, slides have Representation, Data
~ Range..., and Format & Precision options in their pop-up menus. These
options work the same as they do for digital displays, except that slides

1}
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cannot represent complex numbers. Slides also have other options. The
following illustration shows a slide pop-up menu.

Change to Indicator
Find Terminal

Show

Data Operations
Create Attribute Node
Replace >

h 4 4

Representation 4
Data Range...
Format & Precision...
Add Slider

Fill Options

Scale

Texnt Labels

wv'w

The Digital Display option in the Show submenu of the pop-up menu
controls whether the slide’s digital display appears.

Slide Scale

The scale submenu options apply to the slide's scale only. The Format
& Precision option functions as described in the Changing the Format
and Precision of Digital Displays section of this chapter. The scale pop-
up menu is shown in the following illustration.

T Y Format © Precision...
v Style 4
Texrt Labels Mapping >

The Style option gives you the palette shown in the following
illustration. You can display a scale with no tick marks or no scale
values, or you can hide the scale altogether.
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ot
o

The Mapping item gives you the option of linear or logarithmic scale
spacing, as shown in the following illustration.

v Linear
Logarithmic

If you change to Logarithmic spacing, and the low scale limit is less than
or equal to zero, the limit automatically becomes 1 and LabVIEW
revalues other markers accordingly. Keep in mind that scale options—
including the mapping functions—are independent of the slide data range
values, which you change with the Data Range pop-up option. If you
want to limit your data to logarithmic values, you need to change the data
range to eliminate values less than or equal to zero.

Changing Scale Limits

- The scale of a numeric control or indicator has two or more markers,
which are labels that show the value associated with the marker position.
The outer two markers are the scale limits, and they are not required to -
coincide with the range limits, but can be a subset of the range of the
control or indicator. For example, the default range of a 16-bit signed
integer control or indicator is -32,768 to 32,767. However, you can set

the data range to be -1,000 to 1,000 and then set the scale limits to be 0
and 500.
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scale
range
data range '

representation limits

You can change a scale's minimum, maximum, and increment in five
ways using either the Operating tool or the Labeling tool.

If you type a new maximumwvalue into its display, the minimum
stays the same, and LabVIEW recalculates the increment
automatically.

If you type a new minimum value into its display, the maximum
stays the same, and LabVIEW recalculates the increment
automatically.

If you type the current minimum value into the maximum display,
LabVIEW flips the scale so that what was formerly the minimum is
now the maximum, and vice versa. LabVIEW also recalculates the
increments.

If you type into any intermediate marker, the increment becomes
that value minus the minimum.

If you change the size of the slide, the increment adjusts so that the
markers do not overlap.

Text Scale

You can also use text labels on numeric scales. Labels are useful because
they allow you to associate unsigned 16-bit integers with strings. This
configuration is useful for selecting mutually exclusive options. To
enable this option, select Text Labels from the slide pop-up menu. The
slide control appears with default text labels, min and max, and you can
begin typing immediately to enter the labels you want. Press <shift-
enter> after each label to create a new label, and enter after your last label
to finish.

You can use the Labeling tool to edit min and max labels in the text
display or on the slide itself.
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Function

100-FYg—
8.0- Change to Indicator
co-|| Find Terminal
' Show 4
4.0- Data Operations 4
20- Create Attribute Node :
oo-& Replace 4
Representation >
Data Range...
Format & Precision...
Add Slider
Fill Options 4
Scale g

. Tent Labels

Chapter 5

2 [Function
=
roic

max-—

eI

mm-;

You can pop-up on the text display and select Digital Display from the
Show submenu to find out what numeric values are associated with the
text labels you create. These values always start at 0 and increase by 1

for each text label.
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- Use the Add ltem After or Add Item Before option from the text
display pop-up menu to create new labels, as shown in the following

illustration.
Fay
Wolts AC-Ei———
2 Change to Indicator
- fFing
Show 2
Data Dperations 2
Create Attribute Node
_J ......
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